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1
Key Concepts: Public Sector Procurement

Overview of Oracle Contract Lifecycle Management for Public Sector
Oracle Contract Lifecycle Management for Public Sector (CLM) is a comprehensive 
solution for managing procurement processes that need to be performed by federal 
agencies. CLM features are available in OA Framework HTML pages. CLM supports 
FAR, DFARS, and other agency regulations that define the federal business processes, 
and encompasses a full procure-to-pay process flow within Oracle e-Business Suite 
which maximizes benefits to federal users. CLM enables contracting officers to drive 
operational excellence in federal procurement functions and enables the agencies to cut 
procurement costs dramatically. By providing the end-to-end business intelligence with
a single source of data, CLM provides data transparency and visibility and provides 
contracting officers with support for strategic planning and improved decision making.

The following process flow depicts the procurement lifecycle in CLM: 
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Contract Lifecycle Management

The flow starts with the creation of a purchase requisition which is a document that 
represents a requirement or demand for supplies and services. This is associated to an 
acquisition plan that outlines the procurement plan on a larger scale. The purchase 
requisition is converted to a solicitation and the solicitation is sent out to vendors for 
obtaining their quotes/offers. When the offers are received from the vendors, the offers 
are evaluated and the contract is awarded to one of the vendors.

This process depicts all of the major procurement steps from purchase request initiation
and commitment, through competitive solicitation with an offer evaluation phase, and 
ultimate award decision. The process is often not executed in its entirety – several steps 
are optional and at the discretion of the contracting officer depending on the 
procurement process. Some steps may be required by an agency in order to follow it's 
policies and regulations, but from a system's perspective, the steps can be executed 
without every procurement document in the chain. 

Document Numbering
You can create a configurable, intelligent numbering format for CLM documents that 
follow Federal Acquisition Regulations (FAR) and Defence Federal Acquisition 
Regulations (DFARs) processes. Based on your configuration and setup of the 
numbering structure, a document number is defaulted automatically on the CLM 
documents. You can modify the defaulted document number as long as the document is
in draft mode. Lines for CLM documents are automatically numbered in accordance to 
line/ subline numbering conventions used in federal agencies. CLINs are automatically 
numbered with four-character strings (0001, 0002, etc.) which can be modified by the 
user, while SLINs append a two-character string (0001AA, 0001AB, 000101, 000102). The
contracting professional can modify the system assigned line number. 
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Note: To set up the document numbering structure for use in 
purchasing documents, please refer to the Oracle Contract Lifecycle 
Management for Public Sector Implementation Guide.

For more information about Document Numbering, please refer to the appendix - 
Common CLM Functionality, Oracle Contract Lifecycle Management for Public Sector 
Purchasing User Guide. 

Contract Line / Sub-Line (CLIN / SLIN) 
The Contract Line (CLIN) and Sub-line (SLIN) structure is used in all CLM documents, 
including modifications and amendments to the purchasing documents. A Contract 
Line captures information about the item(s) or service(s) to be procured in the contract 
with or without the pricing details. Thus, a Contract Line (CLIN) can be a priced line or 
an informational line. Similarly, sub-lines, which are used to capture additional 
information about the CLIN, can be priced sub-lines or informational sub-lines. 

When a line is added to a CLM document, it is numbered automatically according to 
the line numbering setup that follows federal government regulations. This provides a 
flexible way to configure line numbering. In the CLM document, you can specify if the 
line should be priced or informational, as well as organize them into a complex line and
sub-line structure, in accordance with federal regulations. 

For more information on CLINs/SLINs, please refer to the appendix - Common CLM 
Functionality, Oracle Contract Lifecycle Management for Public Sector Purchasing User Guide
.

Options
You can choose to create an option line on a purchasing document that you intend to 
exercise as a regular line at a future point in time. Instead of modifying / amending the 
source document at a future date, enter the anticipated options that the base line is 
associated to. For example, a software purchase can be entered as a base line. This 
necessarily entails support and training as options for the purchase of a software 
package. Therefore support and training can be entered as option lines as the vendor 
has promised them. At a later date, the options of support and training can be exercised 
as regular purchase order lines because the vendor has now promised to deliver 
support and training. The option lines of support and training, once exercised, can be 
received and invoiced as well. 

This capability in CLM enables the contracting professional to mark lines as Option 
lines – lines which can be exercised later via a modification to the award if desired. 
Option lines can be associated with base lines and often involve follow-on work. Option
lines behave similarly to CLINs/SLINs except they are not funded until exercised after 
the awarding of the contract. 
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A CLIN or SLIN can be further defined as an Option Line. An Option Line stores and 
displays information that is used at a future point in time. 

Options

This diagram explains the flow of Option lines between different CLM users.

For more information on Options, please refer to the appendix - Common CLM 
Functionality, Oracle Contract Lifecycle Management for Public Sector Purchasing User Guide
.

Pricing
Using CLM, contracting professionals are able to price Awards, Orders, IDVs and 
Modifications by specifying federal Contract Types such as Firm Fixed Price, Cost plus 
Award Fee, Time & Materials, Cost Sharing, etc. The Contract Types form the basis for 
determining the price payable to a vendor. Prices are manually entered by the user or 
are defaulted on the purchasing document line depending on the item/supplies/service 
setup. The final price calculation depends on a number of factors: Contract Type, Cost 
Constraint, price of the item/service.

The CLIN or SLIN can be a Priced or Informational line. For pricing calculations to take 
place, the line should be defined as a Priced Line, and not an Informational Line. 

Lines can be Quantity Based or Amount Based. A Quantity Based Line Type enables 
you to enter information for goods/supplies. An Amount Based Line Type enables you 
to enter pricing information about services. Select a value from the Type LOV in the 
Lines region (for each row) to specify if you wish to use a Quantity Based or an Amount
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Based Line. Different Contract Types display depending on the line type you select.

The Contract Type is available on the lines of a Purchase Requisition, an Award, IDV or 
a Solicitation. The Contract Type may be changed by the user depending on business 
requirements. 

The IDC Type field displays for Solicitation documents and IDVs on the line details 
page. 

For more information on Pricing, please refer to the appendix - Common CLM 
Functionality, Oracle Contract Lifecycle Management for Public Sector Purchasing User Guide
.

Incremental Funding
CLM enables you to provide funding information for an Requisition, Award / Order. 
You can create and approve Requisitions, Awards and Orders with no funding or with 
partially available funds. You can incrementally fund the Award / Order lines through 
the Modification feature, depending upon the availability of funds. Additionally, you 
can add funds to an existing distribution or add new distribution(s) to an existing line. 

Due to system-enforced rules, you cannot receive and pay beyond the funded line 
amount thereby ensuring that the obligation cannot be more than the funds available. 

Contract Funding guidelines are outlined in the FAR site. You can reserve funds for a 
Requisition or Award line and ensure that the line amount is equal to or less than the 
reserved or encumbered amount. Enter the funded value on purchasing documents 
such as Requisitions and Awards. You can reserve funds as Null, partially or fully, i.e., 
the funded amount can be less than the line amount. You can modify these documents 
without having to liquidate the existing funds on the documents.

Note: IDVs will not have the funded value field, i.e. IDVs cannot be 
encumbered.
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Funding

As shown in the diagram above, an example award of $300 can be incrementally funded
quarter by quarter, based on the fund allocation and availability.

For more information on Funding, please refer to the appendix - Common CLM 
Functionality, Oracle Contract Lifecycle Management for Public Sector Purchasing User Guide
.

Modifications
Part 43 of the FAR site defines contract modifications and the regulations associated 
with them. 

A Modification is a procurement instrument used in the post-award process for making 
a change to the Award or IDV. The conformed copy is not updated with the 
information from the Modification until the Modification is processed.

When Contract Administrators need to make changes to a conformed award even 
though it has been approved by the relevant approvers, a modification document is 
created. 
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Modification Creation Flow

Using Modifications, you can perform the following: 

• Add funds incrementally 

• No-Cost cancellation of an award 

• Partially terminate an award or line, for default or convenience 

• Exercise Options 

• Provide ability for the supplier to indicate acceptance by signing the document

• Specify proxy signature on behalf of the supplier 
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• View the changed values for the pricing fields (quantity, pricing, line amounts etc.) 

A System Generated Description, containing the statements describing the changes 
carried out using a modification, is generated automatically prior to finalization and 
approval of the modification. This description gets printed as part of the SF30 form 
generated for modifications.

For more information on Modifications, please refer to the chapter Modifications, Oracle
Contract Lifecycle Management for Public Sector Purchasing User Guide. 
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2
Introduction to iSupplier Portal

Overview
Oracle iSupplier Portal enables a buying company to communicate key procure-to-pay 
information with suppliers. As a supplier using Oracle iSupplier Portal, you can view 
and acknowledge awards, submit change requests (available for commercial documents
only) , create advance shipment notices, view receipts, view inventory levels (available 
for commercial documents only), view invoices and payments, create work 
confirmation for complex work projects, and acknowledge award change requests. As a 
buyer using Oracle iSupplier Portal, you can view order, shipment, receipt, invoice, and
payment information.

Note: The iSupplier Portal supports both commercial and public sector 
documents You can make change requests only for commercial 
documents.

This section is an introduction to Oracle iSupplier Portal, and includes the following 
topics:

• About Oracle iSupplier Portal, page 2-2

• How to Use This Guide, page 2-2

• Getting Started Information, page 2-2

• Transaction and View Only Document Information, page 2-2

• Profile Information, page 2-3

• Buying Company View, page 2-3

• Where to Start, page 2-3
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About Oracle iSupplier Portal
Oracle iSupplier Portal is a collaborative application that enables buying companies and
their suppliers to communicate with each other. It enables suppliers to have real-time 
access to information (such as awards and delivery schedules) and respond to the 
buying company with acknowledgments, change requests, shipment notices, and 
planning details. It also allows buying organizations to search for awards, shipment, 
receipt, invoice, and payment information across all suppliers and all business units, as 
well as respond to supplier change requests.

Note: Oracle iSupplier Portal supports both transaction documents and 
view-only documents. Using transaction documents, you can submit 
acknowledgments or change requests on an Award, or initiate 
transactions such as advance shipment notices, advanced shipment 
billing notices, and invoices. Using view-only documents, you may 
view forecast schedules and payments.

How to Use This Guide
This guide is organized to help you learn, use, and understand Oracle iSupplier Portal.

Getting Started Information
Introduction to Oracle iSupplier Portal

Explains how you get started using Oracle iSupplier Portal. This chapter includes 
details of where you start using the system depending on your current relationship 
with the buying company.

Registration

Explains how to register your company with the buying company and how to get 
Oracle iSupplier Portal user accounts for your employees. If you already have access to 
Oracle iSupplier Portal, then you do not need to read this chapter.

Navigating and Searching 

Explains how to navigate through the system. The chapter also includes searching tips 
and techniques.

Transaction and View Only Document Information
Awards Information

Explains how to view and respond to awards-related documents such as awards, work 
orders, modifications, and IDVs.
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Shipping Information

Explains how to access shipping information and create advance shipment notices 
(ASNs or ASBNs). The chapter also includes information on viewing receiving and 
quality transactions.

Planning and Inventory Information

Explains how to access planning and inventory information, as well as how to maintain 
item and capacity information.

Invoice and Payment Information

Explains how to access invoice and payment information. The chapter also includes 
information on how to submit invoices if the buying company has Oracle Payables 
installed.

Profile Information
Supplier Profile Management

Explains how to maintain information about your company using the Supplier Profile 
Management feature. You must have the proper authorizations to access the profile 
management pages.

Buying Company View Information
Buying Company View

Explains the buying company view of iSupplier Portal.

Where to Start
Before you can access Oracle iSupplier Portal:

1. Your company must be registered as a supplier to the buying company that has 
licensed Oracle iSupplier Portal.

2. You must be registered as an Oracle iSupplier Portal user.

Note: If you are already a supplier to the buying company and you 
can log into Oracle iSupplier Portal, then you and your company 
have already completed both of the registration tasks. You can skip 
chapter 2. If you do not have access to Oracle iSupplier Portal, see 
chapter 2 for registration instructions.

After you are registered, you can access Oracle iSupplier Portal. The tasks you perform 
on Oracle iSupplier Portal are determined by your current supply chain business 



2-4    Oracle Contract Lifecycle Management for Public Sector iSupplier Portal User Guide

relationship with the buying company. The tables below list the tasks you will likely 
perform; where you start depends on what you want to accomplish:

If the buying company has ordered goods or services from you, you can

Tasks Where Documented

View existing awards from your buying 
company, including any attachments.

See: Award Information, page 5-1

Acknowledge and submit change requests to 
awards.

See: Award Information, page 5-1

Submit your electronic signature while 
acknowledging an award.

See: Award Information, page 5-1

View and print Portable Document Format 
(PDF) versions of award documents, 
including blanket IDVs, clauses and other 
contract terms.

See: Award Information, page 5-1

View and print Portable Document Format 
(PDF) versions of modifications.

See: Using Modifications, page 5-16

View your current IDVs (if any) with the 
buying company.

See: Award Information, page 5-1

View an audit trail of any revisions for an 
award.

See Award Information, page 5-1

Manage deliverables assigned to you 
(available only if the buying company has 
implemented Oracle Procurement Contracts).

See: Award Information, page 5-1

Create work confirmations to notify the 
buying company of expected payment related 
to a completed unit of work for a complex 
work project. 

See: Award Information, page 5-1

View timecard information (available only if 
the buying company has implemented Oracle 
Services Procurement and Oracle Time and 
Labor).

See: Award Information, page 5-1
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Tasks Where Documented

Let your buying company know that goods 
are ready for shipment by uploading a routing
request. 

See: Shipping Information, page 6-1

View buying company's response to your 
routing request.

See: Shipping Information, page 6-1

Alert the buying company of any upcoming 
deliveries by sending advance shipment 
notices (ASN) or advance shipment billing 
notices (ASBN).

See: Shipping Information, page 6-1

Upload advance shipment notices (ASN) or 
advance shipment billing notices (ASBN) to 
the system using spreadsheet functionality. 

See: Shipping Information, page 6-1

View and enter item quality results and check 
for correspondence from the buying company 
(available only if the buying company uses 
Oracle Quality).

See: Shipping Information, page 6-1

View receipts, returns, and delivery 
performance.

See: Shipping Information, page 6-1

If you have already made a shipment to the buying company, you can:

Tasks Where Documented

View invoices and received payments. See: Invoice and Payment Information, page 8-
1

Submit invoices by selecting a award and 
direct-billing the buying company (available 
only if the buying company uses Oracle 
Payables).

See: Invoice and Payment Information, page 8-
1

If you require a third-party shipment before you can complete the buying company's 
award, you can:
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Task Where Documented

View work orders to check the status of 
third-party (outside processing) orders or 
shipment plans.

See: Award Information, page 5-1

See:Shipping Information, page 6-1

If you want to view and update your inventory information, you can:

Tasks Where Documented

View item inventory levels. See: Planning and Inventory Information, 
page 7-1

Maintain item attributes, such as delivery 
capacity and lead times.

See: Planning and Inventory Information, 
page 7-1

Enter capacity information and view on-hand 
delivery items.

See: Planning and Inventory Information, 
page 7-1

Define inventory lead times and order 
modifiers.

See: Planning and Inventory Information, 
page 7-1

View vendor managed inventory items (if 
items are set up as a vendor managed items) 
and generate supply requests to manage 
reorder points and replenishments

See: Planning and Inventory Information, 
page 7-1

View consigned inventory stock and view 
transactions associated with that stock.

See: Planning and Inventory Information, 
page 7-1

If you want to view forecast demand so you can evaluate your supply plans, you can:

Task Where Documented

View forecast schedules. See: Planning and Inventory Information, 
page 7-1

View a summary of forecast schedules. See: Planning and Inventory Information, 
page 7-1

If you want to update your company's profile information, you can:
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Task Where Documented

Enter address book information, contact 
directory information, business classifications,
and products and services you provide. You 
can also enter and maintain bank account and 
address information, as well as payment and 
invoicing methods.

You can enter and maintain information on 
user accounts. 

Note: You cannot update CCR records if 
you use public sector documents.

See: Supplier Profile Management, page 9-1

If you want to negotiate to supply goods to the buying company, you can:

Task Where Documented

View buyer requests for quotes (RFQs). See: Solicitations, page 5-18

If you are a buyer, you can:

Task Where Documented

View award, shipment, receipt, invoice, and 
payment information.

See: Buyer information, page 10-1

Search for award, shipment, receipt, invoice, 
and payment information across all suppliers 
and all business units.

See: Buyer information, page 10-1

Respond to supplier change requests. See: Buyer information, page 10-1
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3
Registration

Overview
You register your company as a prospective supplier in Oracle iSupplier Portal to let the
buying company know that you are interested in establishing a business relationship. 
After you are registered, additional supplier users within your company can be 
registered to access and use Oracle iSupplier Portal. This enables you to communicate 
to a buying company real-time information about your procure-to-pay transactions.

Note: If you are already a supplier to the buying company and you can 
log into Oracle iSupplier Portal, then you and your company have 
already completed both of the registration tasks. You can skip chapter 
2. 

Note: If no one in your company can access Oracle iSupplier Portal, 
your company is not registered with the buying company, and you 
need to register your company before you register your supplier users. 

Note: If other supplier users in your company can access Oracle 
iSupplier Portal (and you cannot), your company is registered, 
however, you need to register as a user for access to Oracle iSupplier 
Portal. 

If you are a prospective supplier, you need to read the entire section and complete all of
the registration steps. If your company is already registered with the buying company 
and you only need to add yourself as a user, you only need to read and complete the 
Registering Users task.

This section includes the following topics:

• Registering Suppliers, page 3-2
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• Registering Users, page 3-2

Registering Suppliers
Self-service prospective vendor registration enables you to register your interest in 
establishing a business relationship with the buying company. Once registered, you can
provide details about your company, its addresses, contacts, products and services, and 
banking and payment information.

To register, you need to provide your company name, tax identification details, and 
main company address. This information is verified against existing records to ensure 
that duplicate registration information is not recorded. You can also include additional 
detailed information to create a company profile. If the buying company wishes you to 
enter into a relationship with them, they may send you an invitation requesting you 
register with the system. This notification will contain a URL where you can go and 
access the Supplier Registration Page. If the buyer does not send you an invitation, you 
must obtain this URL from the buying company yourself. Either way, you enter details 
about your company using the Supplier Registration Page. 

You must provide contact information so the system can send updates on the 
registration request. After completing the registration, you receive a confirmation that 
the request has been submitted for review. The information is reviewed by a buyer 
administrator, and if approved, you are notified of the decision by e-mail.

Registering Users
The buying company initiates the process of adding new supplier users by inviting 
supplier users to register, or by registering supplier users directly. If you receive an 
invitation to access Oracle iSupplier Portal, you can respond to the invitation (and 
provide user profile information, such as name and contact details), or forward the 
invitation to another user in your company. For example, the buying company may 
send an invitation to the Vice President of Sales within your organization; he can 
forward it to the appropriate person in his company. The user who responds can 
change any of the details except the name of the supplier company for whom he or she 
is registering.

If the buying company has multiple site definitions for your company, or if you have 
multiple subsidiaries, your buying company may give you access to view information 
for multiple site definitions.

If you wish to register with the system, you must complete the Supplier User 
Registration Page and submit it for approval 

A buyer administrator will approve or reject the your registration request. You receive a
notification of the buyer administrator's actions. The notification includes the URL at 
which you can access the network, plus any additional information such as the 
username and a system-generated password needed for initial login. (You will be 
prompted to change this password after first login.)
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Buyers can designate a supplier user with user account from the Contact Directory to 
receive the business classification reminder notifications. To designate the supplier 
users expand the user account information node and select Certification Reminders 
check box in the User Notification region. 

Directly Registered Supplier Users

If the buying company has enough information about a user at your company, the 
buyer can chose to register the user directly, in which case the users receives an e-mail 
notification with the URL, username, and system-generated password.

Supplier Registered Supplier Users

If additional people in your company need access to Oracle iSupplier Portal, they 
should contact the Supplier Profile and User Administrator at your company. This 
administrator can create new user accounts for your users. Once the account is created, 
the user will be sent a notification containing system access information.
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4
Navigating and Searching

Overview
This section includes information to help you learn how to navigate and search in 
Oracle iSupplier Portal. After you learn the basic techniques, you will be able to search 
for transaction information, and respond accordingly.

This section includes the following topics:

• Using the Oracle iSupplier Portal Home Page, page 4-1

• Setting Up User Preferences, page 4-3

• Searching, page 4-4

Using the Oracle iSupplier Portal Home Page 
Use the Oracle iSupplier Portal Page to navigate through the application. By default, 
when you access the Oracle iSupplier Portal application using the username and 
password provided to you, the Oracle iSupplier Portal Home page displays. You can 
click the Orders, Shipments, Planning, Finance, Product, Intelligence, and Admin.tabs 
to quickly access related task areas. Depending on your authorizations, the Admin and 
Intelligence tabs may not display

To view or work with a specific item, you can use the search facility to locate the 
specific Award Number, Shipment Number, Invoice Number, Payment Number, or a 
Modification Number.

The Quick Links section displays on the right and provides a high-level diagram of the 
procure-to-pay flow through the Oracle iSupplier Portal application. Click any link to 
go directly to the corresponding page. The quick links you can use are Forecast 
Schedules, IDVs, Awards, Purchase History, Modifications, Delivery Schedules, 
Overdue Receipts, Advance Shipment Notices, Receipts, Returns, On-Time 
Performance, Invoices, and Payments.
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The Notifications region displays the most recent messages awaiting your review. To 
view the full list of all notifications, click the Full List button in this region.

Some notifications are view-only, while other notifications require action. To view your 
notifications, click the linked subject to open the Notification Details page. This page 
provides complete notification details, as well as the appropriate action button. On the 
Notification Details page you can request further information or assign the notification
to another user.

If you select an action on the Notification Details page and click, you are returned to 
the Notifications Summary page. 

On this page you can view all your notifications.

You can use the View menu to see 

• All your notifications

• Information only (FYI) notifications

• Notifications you have sent 

• Open notifications

• Notifications requiring action by you (To Do Notifications) 

To process a notification, select the notification and assign it to another user, or open 
and view/process it. Once you have processed the necessary notification you can: 

• Continue to respond to any additional notifications you have.

• Continue working by clicking any of the tabs.

The Awards at a Glance region displays the five most recent awards. Click an award 
number to view the award details. Click the linked award number to view the award 
details. To view the full list of awards, click the Full List button in this region.

The Shipments at a Glance region displays displays recent shipments. Click a shipment
number to view the shipment details. To view the full list of shipments, click the Full 
List button in this region.

The Modifications at a Glance region displays the most recent modifications. Click a 
modification number to view the modification details. To view the full list of 
modifications, click the Full List button in this region.

Home Page Links

The links at the top of the Home page provides the following information:

Global Buttons

The following buttons display on the home page and all Oracle iSupplier Portal pages:

• Home - Returns you to the main portal where you can select another responsibility 
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or application.

• Logout - logs you out of the application.

• Preferences - Displays the Preferences page. 

See Setting Up User Preferences , page 4-3 for information on setting your user 
preferences.

• Personalize - Use this button to personalize the page per your business 
requirements.

• Diagnostics - Use this to set diagnostics levels.

• Help - Accesses the help index page.

Setting Up User Preferences
You can change your user settings or preferences at any time using the Preferences icon.
You can change the following preferences:

• General - You can select your language, territory, time zone, client character 
encoding (the character set that's used in your page display), and accessibility 
features (such as screen reader use). 

Note: Date and time values are always displayed to you in the time 
zone you set in your user preferences, even if your buying 
company is in a different time zone.

• Notification - You can select how you want to receive your notifications (for 
example, in HTML or plain text e-mail).

• Formatting - You can define your date format and number format.

• Password - You can reset or change your password. A valid password must be at 
least five, but no more than 30, characters. Passwords can be numeric, 
alphanumeric, or special characters.

To change your preferences

• Click the Preferences icon.

• On the Preferences page, enter your name in the Known As field.

• Complete or update the required fields.

• Click Apply to save your changes. Click Cancel to return to the system without 
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making any changes.

Searching
Oracle iSupplier Portal provides extensive search criteria on all pages to help you 
retrieve information. Once you have your search results displayed, you can sort them 
by clicking any of the linked column headings. 

When entering search values, you can use the percent sign (%) as a wildcard to search 
for generic items. For example, to search for all orders beginning with 27 and end in a 5 
(such as 275, 2715, 27125) enter 27%5. To search for all orders, you can use the wildcard 
character % and search. The % wildcard character can be a substitute to any number of 
characters. Note the search logic attempts to find matches containing values in any 
position. 

There are three types of search functions available to you.

• Quick Search, page 4-4

• Simple Search, page 4-4

• Advanced Search, page 4-4

Quick Search

The Quick Search feature is available to you from the Home page.

To use the Quick Search: 

1. Select the search type from the Search menu. You can choose from Award Number, 
Shipment Number, Invoice Number, Payment Number, or Modification Number.

2. Enter a search value.

3. Click Go.

Simple Search

The Simple Search feature occurs on many pages and allows you so specify multiple 
search fields and enter criteria for each. You can use any or all of the fields available to 
you. The system displays only those results that match all the criteria you entered.

Advanced Search

Advanced Search allows you to build complex search queries containing multiple 
search criteria. You can select which fields you wish to search on and enter search 
values for each. The fields you can search on depend on the item you search, for 
example, if you want to conduct an advanced search on Awards, you can use search 
criteria such as Document Number, Document Type, Document Sign Date, and Buyer.

You can use the default search fields that appear for that page's Advanced Search 
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function, or apply additional search fields from the "Add Another" menu for the page.

Search operators enable you to specify the matching conditions for a search. Available 
search operators are:

• is - Use this operator for an exact match.

• is not - Use this operator to exclude a specific match.

• contains - Use this operator to find a partial match.

• starts with - Use this operator to find a partial match only at the beginning.

• ends with - Use this operator to find a partial match that only ends with your 
criteria.

• greater than - Use this operator to include results greater in value than a value 
specified.

• less than - Use this operator to include results lower in value than a value specified.

• after - Use this operator to include results with a date after the specified date.

• before - Use this operator to include results with a date before the specified date.

Note that you can use the same search field twice to specify a search range, for example 
a Ship Date range. Also note that you can choose to require the results to match all 
search criteria (resulting in a more focused, narrower set of results) by selecting the 
option "Show table data when all conditions are met," or allow a match of any of the 
search criteria (resulting in a larger set of results) by selecting the option "Show table 
date when any condition is met." 

To search for Awards:

You use the Views page to view details of All Awards, Awards to Acknowledge, and 
Awards Pending Supplier Change.

See: Viewing Awards, page 5-3

Click the Advanced Search button to conduct an advanced search for awards as follows:

1. Enter the Document Number.

2. Select the Document Type.

3. Select the Document Sign Date. Choose from Last 30 Days, Last 60 Days, Last Week,
and Today.

4. Select the Buyer from the list.

5. Enter parameters and values to filter your results.
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See: Advanced Search, page 4-4

6. Click Go. You can view the following details in the search results:

• Document Number

• Revision

• Operating Unit

• Document Type

• Description

• Document Sign Date

• Buyer

• Currency

• Amount

• Status

• Acknowledge By

• Attachments

7. See: Awards, page 5-2 for more information on the actions you can perform.

8. Click the Document Number link in the search results to view details of the specific 
document.

9. Click the Rev link to see details of the revision.

10. Click the Buyer link in the search results to view details of the specific buyer.

11. Click the Attachments icon to see the attachments.

12. Click Change Multiple Documents to update multiple documents.

13. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for IDVs:

1. Enter the IDV Number.

2. Select Yes or No from the Global list.
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3. Enter the Award Start Date.

4. Enter the Award End Date.

5. Enter the Issuing Office Address. This is optional if you use advanced search.

6. Enter an Effective Date. This is optional if you use advanced search.

7. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

8. Click Go. You can view the following details in the search results:

• IDV Number

• Revision

• Global

• Description

• Buyer

• Creation Date

• Currency

• Amount Agreed

• Amount Released

• Award Start Date

• Award End Date

• Status

• Attachments

• Upload Status

• Issuing Office Address

• Effective Date

9. Click the IDV Number link in the search results to view details of the specific IDV.

10. Click the Buyer link in the search results to view details of the specific buyer.
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11. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Modifications:

1. Enter the Modification Number.

2. Enter the Document Number.

3. Select a Buyer.

4. If you use advanced search, enter the Modification Effective Date.

5. You can also add further search criteria such as Modification Issuing Office, 
Modification Status, and Termination Indicator.

6. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

7. Click Go. You can view the following details in the search results:

• Modification Number

• Description

• Document Type

• Organization

• Supplier

• Supplier Site

• Document Number

• Modification Effective Date

• Amount

• Currency

• Status

• Buyer

8. Click the Modification Number link in the search results to view details of the 
specific modification.

9. Click the Document Number link in the search results to view details of the specific 
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document.

10. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Deliverables:

1. Enter the Deliverable Name.

2. Select the Status from the list. You can choose from Cancelled, Completed, Failed to 
Perform, Open, Rejected, and Submitted.

3. Enter the Due Date From.

4. Enter the Due Date To.

5. Select the Document Type. You can choose from IDV with Lines, IDV without 
Lines, Award, IDV with Lines Modification, IDV without Lines Modification, and 
Award Modification.

6. Click Go. You can view the following details in the search results:

• Deliverable Name

• Deliverable Type

• Document Type

• Document Number

• Party Name

• Contact

• Due Date

• Status

• Alert

• Update

7. Click the Deliverable Name link in the search results to view the details of the 
specific deliverable.

To search for Work Confirmations:

You use the Views page to view details of the Last 25 Work Confirmations, Draft Work 
Confirmations, Rejected Work Confirmations, or All Work Confirmations.

See: To view/update existing work confirmations in Using Work Confirmations, page 5-
12
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Click the Advanced Search button to conduct an advanced search for awards as follows:

1. Enter the Work Confirmation.

2. Enter the Request Date.

3. Enter the Award Number.

4. Enter the Period From Date.

5. Add additional search criteria such as Period To Date, as required.

6. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

7. Click Go. You can view the following details in the search results:

• Work Confirmation

• Request Date

• Period From

• Period To

• Award Number

• Currency

• Awarded

• Previous Requested

• Previous Delivered

• Current Requested

• Current Delivered

• Total Progress (%)

• Status

8. Click the Work Confirmation link in the search results to view details of the specific 
work confirmation.

9. Click the Award Number link to see details of the specific award.
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10. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Procurement History:

1. Enter the Document Number.

2. Enter the Release Number. This is optional in advanced search.

3. Enter the Revision in the Rev field.

4. Select a Document Type from the list.

5. Enter the Creation Date. This is optional in advanced search.

6. Enter the Revised Date. This is optional in advanced search.

7. Select the Operating Unit from the list. This is optional in advanced search.

8. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

9. Click Go. You can view the following details in the search results:

• Document Number

• Revision

• Operating Unit

• Description

• Buyer

• Creation Date

• Revised Date

• Currency

• Total

• Ship-to-Location

• Compare to Original Document

• Compare to Previous Document

• Show All Changes
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10. Click the Document Number link in the search results to view the details of the 
specific document.

11. Click the Buyer link to see details of the Buyer.

12. Click the Ship-to-Location to view details of the location.

13. Click the Compare to Original Document icon to compare the current document 
with the original document.

14. Click the Compare to Previous Document icon to compare the current document 
with the previous version.

15. Click the Show All Changes icon to view all the changes.

16. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Delivery Schedules:

1. Select the Organization from the list.

2. Enter the Award Number.

3. Select a Supplier Item from the list. This is optional in advanced search.

4. Enter the Item Description. This is optional in advanced search.

5. Select the Item Number from the list.

6. Select the Ship-To-Location from the list.

7. Enter the Promised Date. This is optional in advanced search.

8. Enter the Need-By-Date. This is optional in advanced search.

9. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

10. Click Go. You can view the following details in the search results:

• Organization

• Award Number

• Supplier Item

• Item Description
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• UOM

• Quantity Awarded

• Quantity Received

• Ship-To-Location

• Carrier

• Item Number

• Supplier Config ID

• Supplier

• Supplier Location

• Promised Date

• Need-By-Date

11. Click the Award Number link in the search results to view details of the specific 
award.

12. Click the Quantity Received link in the search results to view details of the receipt 
transactions.

13. Click the Ship-To-Location link in the search results to view details of the location.

14. Click the Supplier Location link in the search results to view details of the supplier's
location.

15. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Shipment Notices:

You use the View/Cancel Advance Shipment Notice page to view details of the Last 25 
Shipment Notices or All Work Confirmations.

See: Viewing and Canceling Advance Shipment Notices and Advance Shipment Billing 
Notices, page 6-7

Click the Advanced Search button to conduct an advanced search for awards as follows:

1. Enter the Shipment Number.

2. Enter the PO Number.

3. Enter the Ship-To-Location.
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4. Enter the Supplier Site.

5. Add additional search criteria such as Bill of Lading, Freight Carrier, Item, Packing 
Slip, Supplier Item, Supplier Site, View, or Waybill/Airbill Number, as required.

6. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

7. Click Go. You can view the following details in the search results:

• Shipment Number

• Shipment Date

• Expected Receipt Date

• Freight Carrier

• Waybill/Airbill Number

• Supplier Site

• Invoice Number

• Packing Slip

• Processing Status Code

• Cancellation Status

8. Click the Shipment Number link in the search results to view details of the specific 
shipment.

9. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Shipment Schedules:

1. Enter the Schedule Number.

2. Enter a Revision.

3. Enter a Schedule Type.

4. Select the Forecast/Release Type from the list.

5. Enter the Horizon Schedule Start. This is optional in advanced search.

6. Enter the Horizon Schedule End. This is optional in advanced search.
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7. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

8. Click Go. You can view the following details in the search results:

• Schedule Number

• Revision

• Schedule Type

• Forecast/Release Type

• Schedule Horizon Start

• Schedule Horizon End

• Ship to Organization

• Ship-To-Location

• Status

• Schedule Type

• Supplier

• Supplier Site

• Supplier Organization ID

9. Click the Schedule Number link in the search results to view details of the specific 
schedule.

10. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Receipts:

1. Enter the Receipt Number.

2. Enter the Award Number.

3. Enter the Release Number. This is optional in advanced search.

4. Enter the Shipment Number. This is optional in advanced search.

5. Enter the Shipped Date.
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6. Select the Organization from the list.

7. Select the Item Number from the list. This is optional in advanced search.

8. Select the Supplier Item from the list. This is optional in advanced search.

9. Enter the Item Description. This is optional in advanced search.

10. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

11. Click Go. You can view the following details in the search results:

• Receipt

• Creation Date

• Organization

• Shipment

• Shipped Date

• Packing Slip

• Containers

• Waybill/Airbill

• Freight Carrier

• Bill of Lading

• Award Number

• Invoice

• Attachments

12. Click the Receipt link in the search results to view details of the specific receipt.

13. Click the Award Number link in the search results to view details of the specific 
award.

14. Click the Invoice link in the search results to view details of the specific invoice.

15. Click the Attachments link in the search results to view details of the attachment.
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16. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Returns:

1. Select the Organization from the list.

2. Enter the Award Number.

3. Enter the Receipt Number.

4. Enter the Shipment Number.

5. Enter the Shipped Date. This is optional in advanced search.

6. Enter the RMA Number. This is optional in advanced search.

7. Select the Item from the list. This is optional in advanced search.

8. Select the Supplier Item from the list. This is optional in advanced search.

9. Enter the Item Description. This is optional in advanced search.

10. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

11. Click Go. You can view the following details in the search results:

• Organization

• Receipt Number

• Award Number

• Shipment Number

• RMA Number

• Receipt Creation Date

• Item

• Supplier Item

• Item Description

• UOM

• Quantity Received
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• Quantity Returned

• Return Date

• Reason

• Supplier Config ID

12. Click the Receipt Number link in the search results to view details of the specific 
receipt.

13. Click the Award Number link in the search results to view details of the specific 
award.

14. Click the Shipment Number link in the search results to view details of the specific 
shipment.

15. Click the RMA Number link in the search results to view details.

16. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Overdue Receipts:

1. Select the Organization from the list.

2. Enter the Award Number.

3. Select the Item from the list.

4. Select the Supplier Item from the list.

5. Enter the Due Date. This is optional in advanced search.

6. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

7. Click Go. You can view the following details in the search results:

• Organization

• Award Number

• Item

• Supplier Item

• Item Description
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• Due Date

• UOM

• Quantity Awarded

• Quantity Received

• Ship-To-Location

• Carrier

• Buyer

• Supplier Config ID

8. Click the Award Number link in the search results to view details of the specific 
award.

9. Click the Ship-To-Location link in the search results to view details of the address.

10. Click the Buyer link in the search results to view details of the buyer.

11. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for On-Time Performance:

1. Select the Organization from the list.

2. Enter the Due Date.

3. Enter the Receipt Number. This is optional in advanced search.

4. Select the Supplier Item from the list. This is optional in advanced search.

5. Select the Delivery Status from the list. You can choose from Early, Late or 
On-Time. This is optional in advanced search.

6. Enter the Award Number.

7. Enter the Shipment Number.

8. Select the Item from the list. This is optional in advanced search.

9. Enter the Waybill/Airbill Number. This is optional in advanced search.

10. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4
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11. Click Go. You can view the following details in the search results:

• Organization

• Award Number

• Due Date

• Shipment Number

• Receipt Number

• Receipt Date

• Item

• Supplier Item

• Description

• UOM

• Quantity Received

• Waybill/Airbill Number

• Carrier

• Delivery Status

• Configuration ID

12. Click the Receipt Number link in the search results to view details of the specific 
receipt.

13. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Quality Shipments:

1. Enter the PO Number.

2. Enter the Shipment Number.

3. Select the Supplier Item from the list. This is optional in advanced search.

4. Select the Item from the list. This is optional in advanced search.

5. Enter parameters and values to filter your results.
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See: Advanced Search, page 4-4

6. Click Go. You can view the following details in the search results:

• PO Number

• PO Line

• Shipment Number

• Supplier Item

• Item

• Item Revision

• Description

• UOM

• Quantity Ordered

• Quality Plans

7. Click the PO Number link in the search results to view details of the specific PO.

8. Click the Quality Plans link to view the quality plans.

9. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Planning Schedule Summary:

1. Enter the Schedule Number.

2. Enter the Revision.

3. Select a Forecast/Release Type.

4. Enter a Schedule Horizon Start date.

5. Enter a Schedule Horizon End date. This is optional in advanced search.

6. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

7. Click Go. You can view the following details in the search results:

• Schedule Number
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• Revision

• Creation Date

• Forecast/Release Type

• Schedule Horizon Start

• Schedule Horizon End

• Ship-To Organization

• Status

• Schedule Type

• Supplier

• Supplier Site

• Supplier Organization ID

• Schedule Type

• Summarized View

8. Click the Schedule Number link in the search results to view details of the specific 
schedule.

9. Click Revision to see the details of the revision.

10. Click Supplier to see details of the supplier.

11. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Invoices:

1. Enter the Invoice Number.

2. Enter the Invoice Date From.

3. Select the Invoice Status. You can choose from Cancelled, In Negotiation, In 
Process, and Unsubmitted.

4. Enter the Purchase Order Number.

5. Enter the Invoice Amount. This is optional in advanced search.
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6. Enter the Invoice Date To.

7. Enter the Currency.

8. Click Go. You can view the following details in the search results:

• Invoice Number

• Invoice Date

• Invoice Currency Code

• Invoice Amount

• Purchase Order

• Status

• Withdraw

• Cancel

• Update

• View Attachments

9. Click the Invoice Number link in the search results to view details of the specific 
invoice.

10. Click Purchase Order to see the details of the PO.

11. Click View Attachments icon to see details of the attachment.

12. Click Export to export the search results to a Microsoft Excel spreadsheet.

To search for Supplier Items:

1. Select the Supplier Item from the list.

2. Select the Item from the list.

3. Enter the Item Description.

4. Enter parameters and values to filter your results.

See: Advanced Search, page 4-4

5. Click Go. You can view the following details in the search results:
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• Organization

• Supplier Item

• Item

• Item Description

• UOM

• Orders

• Overdue

• Receipt History

• Defects

• Returns

• On-Time Performance

• Inventory

• VMI

• Consigned Inventory

6. Click the Buyer link in the search results to view details of the specific buyer.

7. Click the relevant icons against Orders, Overdue, Receipt History, Defects, Returns, 
On-Time Performance, and Inventory to view specific details.

8. Click Export to export the search results to a Microsoft Excel spreadsheet.
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5
Award Information

Award Information
The real-time data provided in Oracle iSupplier Portal allows you to communicate 
procure-to-pay information with the buying company while viewing the award flow.

Using award information, you can acknowledge awards, make change requests to 
awards, split shipments, or cancel awards. You can also view IDVs and the revision 
history of a purchasing document.

Note: The change requests, split shipments, and cancel awards features 
are available only for commercial awards.

This section includes the following topics:

• Awards, page 5-2

• Managing Deliverables, page 5-14

• Work Orders, page 5-15

• IDVs, page 5-15

• Using Modifications, page 5-16

• Acknowledging and Signing, page 10-4

• Award Revision History, page 5-18

• Request for Quotes, page 5-18

• Viewing Time Cards, page 5-18
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Awards
When you enter an award in Oracle Purchasing, the award details are available to you 
in Oracle iSupplier Portal. The View Awards page display the most recent 25 awards 
(use the Previous and Next links to view additional awards). Oracle iSupplier Portal 
enables you to track your awards throughout the entire procure-to-pay flow. 

The awards section includes:

• Viewing Awards, page 5-3

• Printing Awards, page 5-5

• Acknowledging Awards, page 5-5

• Submitting Change Requests, page 5-7

Note: The Change Requests functionality is available only for 
commercial awards.

• Splitting Shipments, page 5-10

Note: The Split Shipments functionality is available only for 
commercial awards.

Accessing Awards:

The View Awards page is the central page from which you access and process your 
awards. 

To access an award for further processing: 

1. From the iSupplier Portal Home

page, click the Awards tab.

2. From the View menu, choose the award to display:

• All Awards

• Awards to Acknowledge

• Awards Pending Supplier Change

Click Advanced Search , page 4-4 to further refine your search. You also have the 
option to export the displayed data.

On the resulting View Awards page, select the awards to process. Depending on the 
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status and the type of document you selected, you can choose the following actions 
from the available list of values:

• Select Acknowledge , page 5-5 to acknowledge an award.

• Select View Change History , page 5-10to view award changes.

• Select View Modifications, page 5-16 to view the modifications to the document.

The table below describes the different actions possible in commercial and CLM 
documents.

Document Type Action

Commercial Acknowledge

Request Change

Request Cancellation

View Change History

CLM documents Acknowledge

View Change History

View Modifications

Viewing Awards
You can view details of an award such as terms and conditions, lines, shipments, and 
attachments from the Award Details  page. 

To view the details of an award:

1. Click the Award Number link to access the award to view.

The View Award Details page shows you detailed information about the award, 
including both header and line information. The Award Information section shows 
general information about the award, terms and conditions, Ship-To Address, and 
Bill-To Address, and other ship-to (non-complex work orders), work location (for 
complex-work orders) and bill-to information. 

In the Summary region, you can view the 

• Total - amount of the total award.

• Total Funded Amount - funded amount by accounting distribution
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• Received - amount for the items of the award received

• Invoiced - amount for the items on the award invoiced

• Payment status - status of the invoices against the award.

By selecting options from the Actions menu, you can

• View Modifications

Note: The View Modifications feature is available only for CLM 
documents.

• View Change History

• View PDF

• View Receipts

• View Invoices

• View Payments

• View Shipments

The Summary region on the View Details page for a complex work PO displays 
different information. 

• Approved amount - total approved amount of work confirmations against the PO. 

• Financed amount - total pay item amounts financed plus advanced billed.

• Advanced billed amount - total advance amounts billed at the line level.

• Progress payment - total amount financed or billed of all pay items.

• Delivered - amount of the delivery shipment approved through the work 
confirmation. Delivery shipments are created for orders where progress payments 
are considered contract financing. This field is hidden by default. 

• Recouped - amount of advances and pay items recouped to date. This field is 
hidden by default.

• Retained - amount of pay items retained to date. This field is hidden by default.

The Actions menu options include: 

• View Modifications 
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• View Change History

• View PDF

• View Receipts

• View Invoices

• View Payments

• View Shipments

The Award Details section shows CLIN/SLIN line specific information. Click Show to 
see the receiving, invoicing and payment information for a particular line, or pay item 
information for a complex work line.

Click Export to export the award information to an MS Excel sheet.

Printing
You can view and print Portable Document Format (PDF) versions of awards, including
IDVs. If your buying company has implemented Oracle Procurement Contracts, you 
can also print the contract terms or clauses that the buying company has defined on the 
purchasing documents.

To print awards:

1. Access the award.

2. Select View PDF from the Actions menu, and click Go.

3. On the prompt window, you can choose to open the document immediately, or 
save it locally for later printing.

Note: The printable pdf format is based on the SFxx forms specified on 
the award for CLM documents only.

Acknowledging Awards 
When creating an award, buying companies can request acknowledgment of the award.
If so, you will receive a notification requiring your response. The award may include a 
date by which you need to acknowledge or sign it.

You acknowledge awards to communicate to the buying company that you have 
received, reviewed the details of, and accept or reject an award. You can also 
communicate changes, if you are using a commercial document, to the award during 
acknowledgment.
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You can either acknowledge the award online, or accept or reject the award using the 
notification. The notification does not allow shipment level acknowledgment, which 
must be entered online. When you respond, the award is automatically updated, and a 
notice is sent to the buyer.

You can submit acknowledgments for an entire award, or for individual shipments. For 
example, if you can fulfill only part of an award, accept the shipments you can fulfill, 
and reject the others (note that shipment level acknowledgement cannot be performed 
using the acknowledgement notification).

If the award is set to be acknowledged at the document and shipment levels, you can 
also indicate change requests during acknowledgment. For example, if you cannot 
fulfill a shipment on the given date, but can fulfill it a few days later, you can 
communicate a date change request instead of rejecting the shipment line.

For complex work awards, you can acknowledge pay items.

Note: The value of the need-by date is defaulted to the promised date 
field on supplier acceptance in the acknowledgment process.

To acknowledge awards:

1. Select the award you wish to acknowledge and choose Acknowledge from the 
Select Order list of values.

2. On the Acknowledge page, you can accept or reject an entire award, or you can 
accept or reject individual shipment.

Note: Individual shipment level acceptance/rejection is available 
only for commercial documents.

3. To accept/reject an individual line's shipment or pay item, click Show for the line.

4. For the shipment/pay item, select Accept or Reject from the Action menu. If 
rejecting a shipment or pay item, provide a reason. 

5. Click Submit.

Acknowledging pay items If the terms for a complex-work award terms require 
"document or shipment" acknowledgement, you can accept/reject at the pay item level. 
To accept/reject an individual pay item, click Show for that line. Select Accept or Reject 
from the Action menu at the end of the line (if you reject the pay item, you must also 
provide a reason). If you either accept or reject all the pay items, the award status 
changes to acknowledged.

You can also change a pay item during the acknowledgement phase. To change a pay 
item, modify the appropriate field, select Change from the Action menu, provide a 
reason, and click Submit. Pay item changes are immediately submitted to the buyer for 
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acknowledgement even if the rest of the award is only partially acknowledged. If the 
buyer rejects the change, the award status reverts back to Requires Acknowledgement.

Signing Awards

If your buying company has implemented Oracle Procurement Contracts, your buyer 
may ask that you electronically sign a purchasing document while acknowledging it. 
Legally binding purchasing documents must be signed by both the buyer and supplier.

After you sign the document, your buyer will be notified. The award will be ready for 
execution after both the buyer and supplier have electronically signed the purchasing 
document.

Note: If your buyer asks that you electronically sign a purchasing 
document, you cannot respond at a specific shipment level, you have to
accept or reject the entire award.

To sign a award:

1. Click the Awards tab. Search for and select the award with a status of Requires 
Signature, and then click Acknowledge.

2. On the Acknowledge page, click Sign Document. 

3. Click any attachments you would like to view to review the attachments for terms 
and conditions.

4. Click Accept or Reject.

5. On the Notification Signing page, enter your username and password and click 
Submit.

6. You will receive confirmation that your award has been acknowledged.

Submitting Change Requests
Note: The Change Requests functionality is available only for 
commercial awards.

Oracle iSupplier Portal enables you to request changes to awards when modifications 
are needed to fulfill an award. You can make changes during and after 
acknowledgment. You can change a single award, or, depending on the change you 
need to make, you can update multiple change orders at the same time.

To submit a single change request: 

1. Click the Awards tab, and then click Awards in the task bar below the tabs.
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2. On the View Awards  page, search for and select the award for which you wish to 
request changes.

3. Select the award and Click Request Changes.

4. On the Request Changes page, enter your changes.

5. You can request changes to the following values :

• Price/Price Breaks on Blanket Agreements

• Supplier Item

• Supplier Order Reference Number

6. In the reason text box, enter a reason for your change request.

7. If you wish to request changes to shipments or pay items, click Show. You can 
request changes to

• Price/Price Breaks on Blanket Agreements

• Quantity Ordered 

• Promised Date 

• Supplier Order Line 

• Note that you can also enter change request information in the Additional 
Change Request text box.

8. Enter the changed values as appropriate.

9. Enter a reason for your change.

10. Select the appropriate action.

11. Click Submit. 

Changing complex-work awards

If this is a complex-work award you can only change the supplier item at the line level. 
If progress payments are treated as delivery, price updates are only allowed at the pay 
item level (any changes roll up to the line level). If pay items are considered contract 
financing, then price updates at both the line level and pay item level are allowed.

• Price changes - For milestone and rate, price changes are not allowed if the pay 
item has been partially received or invoiced (that is, retroactive price changes are 
not allowed). For a lump sum, if the pay item has been partially received or 
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invoiced, the new price should equal or greater than the amount received or 
invoiced to date.

Changes in price are prorated to the distributions if the shipment has multiple 
distributions. The buyer can change the distribution amounts during response.

• Quantity changes - 

Quantity changes are only allowed for Rate pay items. If the pay item has been 
partially received or invoiced, the new quantity should be greater than or equal to 
the larger of either the quantity received or the quantity invoiced. A change in 
quantity is prorated to distributions, if the pay item has multiple distributions. The 
buyer can enter new quantities when responding.

Note: After submitting your changes, the award status changes to 
Supplier Changes Pending until the buyer approves the changes.

To update multiple awards simultaneously:

Many times, you may need to make the same change to a group of awards. Depending 
on the type of change you need to make, you may be able to update multiple awards 
simultaneously. You can perform multiple changes to standard awards, IDVs, and 
releases.

For award lines, you can change:

• Unit Price (only for goods lines)

• Supplier Part Number

For award shipments, you can change:

• Promised Date

• Quantity Ordered (only for goods shipments)

• Price (only for shipments with lines where value basis is fixed price). 

To update multiple awards:

1. On the Awards page, click Multiple PO Change.

Note: The Multiple PO Change page displays only commercial 
documents.

2. You can search for shipments to acknowledge or change by selecting 

• Overdue Shipments
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• Shipments Dues in One Week

• Shipments Requiring Acknowledgments

• All Shipments

from the View menu and clicking Go.

3. You search for a group of awards, click the Lines tab and use the advanced search 
option to identify the group of awards you wish to change.

4. If you wish to change the same attribute for multiple awards to the same value: 

1. Enter the new value in the Default Value field.

2. Select the appropriate awards.

3. Click Apply Default Values.

5. If you wish to update multiple award attributes to different values, enter the new 
values directly into the fields in the Lines table.

6. Enter a short text explanation for the change in the Reason field.

7. Click Apply.

Change Requests for Services

Suppliers can request changes to the price for service lines and create new service 
schedules by splitting an existing schedule.

To view change award history:

This view enables you to view the history of change requests submitted on a document, 
and the corresponding buyer response.

1. Click the Orders tab, and then click Awards in the task bar below the tabs.

2. Search for and select an award, and then click View Change History.

3. View the change award history details on the Award Change Order History page.

4. Click OK to return to the Awards page.

Splitting Shipments and Pay Items
Note: The Splitting Shipments and Pay Items functionality is available 
only for commercial transactions.
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You can request to split a shipment. For example, if you can only partially ship the 
quantity ordered for the given date, you can enter a split shipment change request. This 
request will let the buyer know the number of items you can deliver and what date you 
will deliver them.

To request to split a shipment:

1. Click the Orders tab, and then click Awards in the task bar below the tabs.

2. Search for and select an award, and then click Request Changes.

3. On the Request Changes page, click Show to display shipment details.

4. Click the split icon on the desired shipment line. (Another row is added for your 
split shipment).

5. In the Quantity Ordered field of the first shipment line, enter a new quantity.

6. In the Quantity Ordered field of the second shipment line, enter the new quantity.

7. Change the Promised Date.

8. Enter the Supplier Order Line.

9. Enter a reason for splitting.

10. Select an action for change.

11. Click Submit.

Note: You can split a shipment as many times as needed. To create 
more shipment lines, click the split icon. 

Splitting Pay Items for Complex Work awards

The pay items for a complex-work award are stored at the line details level the same 
way as shipment information. Therefore, you can use the instructions above to split an 
existing pay item to create a new payment schedule. A new pay item is created with a 
price of 0 and quantity or 0. You can modify the following fields: 

• Description

• Price (if lump sum, the price on the original pay item should be greater than the 
larger of either the amount received or the amount invoiced). 

• Promised date.
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Using Work Confirmations
Over the course of a complex work project, various pay items defined for the contract 
come due. To notify a buyer that a pay item needs to be processed for a completed unit 
of work, you can create a work confirmation. For partially funded CLM awards, you 
can create work confirmations to the extent of the funded amount specified on the 
award.

To create a work confirmation: 

1. Access the award.

2. On the Award Details  page, select Create Work Confirmation from the Actions 
menu and click Go.

3. From the View menu, select either

• Pay Items Due This Week

• Pay Items Due This Month

• All Pay Items

4. You can also enter and track the progress of the complex work using the following 
fields:

• Previously Requested / Delivered

• Previous Progress %

• Current Requested / Delivered

• Material Stored

Note: The Material Stored field allows the supplier to request a 
payment for material which has been purchased and stored on 
site for use. Using the work confirmation, the supplier can 
enter the requested amount based on work actually completed, 
and has an option for requesting payment for material 
purchased but not yet consumed in work.

• Current Progress %

• Total Requested / Delivered

• Total Progress %
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You can enter / update the values of the Current Progress % and Total Progress 
% fileds, they will be recalculated.

5. Click Go.

6. On the Create Work Confirmation page, select one or more pay items and click 
Next. 

7. Enter a work confirmation ID. 

8. If this work confirmation reflects a particular span of time, optionally enter 
performance period dates.

9. Accept the default or enter a value for Requested/Delivered. .

10. Update the Progress Percentage column, if appropriate. 

11. Click Save to keep a draft work confirmation in the system. You can return tot he 
draft later for make further updates or submit it. When you have finished defining 
your work confirmation, click Submit. Once you click Submit, the approver is 
notified of the work confirmation and must approve it.

To view/update existing work confirmations: 

You can view or update existing work confirmations.

1. From the Awards tab, click the Work Confirmations subtab. 

2. From the View menu, select either

• Last 25 Work Confirmations

• Draft Work Confirmations

• Rejected Work Confirmations

• All Work Confirmations

3. The search results show the progress of the complex work award using the 
following columns:

• Previous Requested

• Previous Delivered

• Current Requested

• Current Delivered
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• Total Progress %

4. Click the work confirmation number to access and view the work confirmation. 

You can select the work confirmation and click Update if you need to make changes
to confirmation or address any issues with a rejected confirmation. You can modify 
details of a rejected work confirmation as well as add additional items. 

If the confirmation has a status of Processing, Rejected, or Pending Approval, you 
can select the confirmation and delete it. 

Note: Work Confirmations may be created by supplier users in 
iSupplier Portal, by buyers in the Buyer Work Center in Purchasing, or 
by iProcurement users in iProcurement.

Canceling Orders or Shipments
Note: The canceling orders or shipments functionality is available only 
for commercial documents.

You can submit cancellation requests for an entire order or a particular shipment. You 
can also submit changes and cancellations at the same time.

1. Click the Orders tab, and then click Awards in the task bar below the tabs.

2. Search for and select an award, and then click Request Cancellation.

3. On the Request Cancellation page, click Submit. 

Note: To cancel a few shipments, but not the entire award, click 
Show in the Award Details section, and then select Cancel from the 
Action list of values (on the shipment line you want to cancel). 
Enter a cancellation reason, and then click Submit.

Managing Deliverables
If your buying company has implemented Oracle Procurement Contracts, you may 
have deliverables assigned to you. Deliverables are tasks to be completed to achieve a 
certain outcome or business objective, and may be used to track projects for compliance 
reasons and risk reduction.

For example, your buyer may ask that you send a monthly status report detailing the 
status of a certain shipment. In this case, your buyer will create a deliverable called 
Send Status Report, and assign the deliverable to you. You will see the Send Status 
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Report deliverable in the notifications section of the iSupplier Portal home page, and 
can manage the deliverable from there, or through the View Order Details page. You 
may attach your status report to the deliverable and change the status of the 
deliverable.

To manage deliverables: 

1. Click the Orders tab, and then click Awards in the task bar below the tabs.

2. Select the award number of the award that includes deliverable(s) you would like to
manage.

3. On the View Order Details page, select Manage Deliverables from the Actions 
menu, and click Go.

4. On the Deliverables page, click the pencil icon on the deliverable you would like to 
update.

5. Update and add attachments to the deliverable as necessary, and then change its 
status to Submitted.

6. Click Apply.

7. You will receive confirmation that your deliverable has been updated. Your buyer 
will also receive notification that the status of the deliverable has been updated.

Work Orders 
Note: The Work Orders functionality is available only for commercial 
transactions.

Using work awards, buyers and suppliers can monitor outside processing from third 
parties whose Work In Process (WIP) status and delivery tracking information is critical
to their supply chain process flow. Outside processing activities are the activities of the 
third-party suppliers who provide services needed to complete the final product or 
maintenance activity.

To view work awards, click the Orders tab, and then click Work Orders in the task bar 
directly below the tabs. Using the search criteria, you can view details of the awards, 
schedules, WIP details, operations instructions, components, and component 
instructions by selecting the links provided. You can also reschedule an award.

IDVs
Supplier IDVs are purchase IDVs you have made with the buying company. On the 
Supplier Agreements page, you can review the details of those IDVs, and the 
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corresponding releases (awards) that have been created for a particular IDV.

To view IDVs, click the Orders tab, and then IDVs in the task bar directly below the 
tabs. Use the search criteria to get a summarized list of IDVs. For each agreement, you 
can select to view the releases created to date for that agreement. You can export details 
from any page.

Editing IDVs

Buying organizations can provide suppliers with the ability to author their own content 
online, either via bulk file upload or on-line authoring. The industry standard formats 
supported in the upload mode include OAG XML, cXML, CIF and text file. Suppliers 
can upload and modify their catalog and buyers only need to approve the upload or 
change requests. Content provided by the supplier is subject to the buyer's approval 
before it is made available to the requesters.

Note: Supplier authoring is not available for CLM IDVs.

To edit a catalog information: 

1. Use the Simple or Advanced Search feature to search for and select the blanket 
award IDV. You can search based on various criteria such as Award Number, 
Global, Effective-From Date, Effective-To Date, Issuing Office Address, and Award 
Effective Date.

2. On the Award: IDVs page, click the award number link in the header.

3. On the Order: IDVs Details page, select Edit Agreement from the Actions menu, 
then the Go button. The catalog authoring page displays for you to start creating or 
modifying a catalog. 

4. After you submit the change, the buyer will receive a notification. The buyer can 
now approve the change through a notification or through the pending change 
page.

Using Modifications
In the case of large-scale procurement, where there are a mixture of materials and 
services on the same contract, the administration of that contract can be cumbersome. 
Major contracts may have several contract administrators assigned to them who 
generate thousands of modifications over the life of the contract. A modification is a 
Procurement Instrument used in the post-award process for making a change to the 
award. When creating a modification, the application assigns a unique supplemental 
numbering sequence that is assigned to the unprocessed Award, Order or Agreement 
Modification, for tracking purposes.

Use the Modifications tab to view details of modifications and the change history of 
your documents.
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Note: The conformed copy is not updated with the information from 
the Modification until the Modification is fully approved.

To use modifications:

1. Use the simple or advanced search feature to access a modification. You can search 
on various criteria such as Modification Number, Award Number, and Buyer.

2. The search results that display include the Modification Number, Description, 
Organization, Supplier, Supplier Site, Award Number, Modification Effective Date, 
Amount, Currency, Status, and Buyer.

3. Click the Modification Number link to view further details of the modification. The 
details that display include General Information such as changed amount, changed 
amount without options, changed funded amount, award number, supplier, 
supplier site, address, created by, award administrator, operating unit, modification
signed and effective dates, modification execution status, modification authority, 
authority text, and justification. In addition, you can view details of terms and 
conditions, and federal office addresses - the Issuing Office, COTR Office, 
Requesting Office, and the Property Administration addresses. The Modifications 
Details section displays details of:

• Award

• CLIN/SLIN line

• Information

• Options

• Type

• Item/Job

• Description

• Contract Type

• UOM

• Quantity

• Price

• Amount

• Funded Amount
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4. Select the modification and select the appropriate action to view change history, 
view PDF, or sign document.

5. Click the Line Details icon to view additional details of the line. The details that 
display include additional item information, pricing information for amount based 
lines and inspection information

6. To export the document to MS Excel, click Export.

Revision History
The Award Revision History page enables you to search for details on the revision 
history of an award.

Using the search criteria, you can get a summarized list of revised awards. You may 
choose to compare each revised award to the original award, the previous award, or last
signed award (if the revised award has been signed). You can also view all changes 
made to the award.

1. From the iSupplier Portal Home page, click the Awards tab, and then click the 
Purchase History subtab.

2. Enter search criteria to identify the award(s) you wish to inspect. Click Go.

3. From the Award Revision History page, for any particular version, you can 
compare it to its previous version, compare it to the original award, or you can 
generate a detailed listing of all changes to the award.

RFQs
Viewing requests for quotes (RFQs) enables you to select possible negotiations to 
participate in with the buying company.

To view RFQs, click the Orders tab, and then click RFQ in the task bar directly below 
the tabs. Enter search criteria in the search fields and click Go. The RFQ Summary page 
provides the details of all RFQs created by the buying company in its ERP application. 
Click any of the links on the RFQ Summary page to get more details about the RFQ.

Viewing Time Cards
Contractors can record hours worked using timecards to receive payments for services 
rendered. You may access these time cards if the Timecards task appears under the 
Orders Tab. You will be able to view timecard information and check the amount of 
time confirmed by the hiring manager.

To view timecards, click the Orders tab, and then click Timecards in the task bar 
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directly below the tabs. Use the search criteria to get a summarized list of timecards. 
Click View Timecard to get more details about the timecard. You can export details 
from any page.
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6
Shipping Information

Shipping Overview
This section includes the following topics:

• Shipping Information, page 6-1

• Receiving Information, page 6-9

• Quality Information, page 6-10

Shipping Information
Oracle iSupplier Portal enables you to view your existing shipments. Using your 
shipments you can create or cancel advance shipment notices. The system enables you 
to view other shipment information such as delivery schedules.

Using shipping features, you can alert the buyer to upcoming shipments and expedite 
receipts and payments for the buying company.

Shipping information details all of your shipping transactions on Oracle iSupplier 
Portal. You can create or cancel shipment notices as well as view shipment delivery 
schedules and overdue shipment receipts.

The shipping information section includes:

• Using Advance Shipment Notices and Advance Shipment Billing Notices, page 6-
4

• Uploading Routing Requests, page 6-8

• Viewing Routing Responses, page 6-8

• Viewing Delivery Schedules, page 6-8
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• Viewing Overdue Receipts, page 6-9

Using Advance Shipment Notices and Advance Shipment Billing Notices
When you enter an Advance Shipment Notice (ASN) or Advance Shipment Billing 
Notice (ASBN), you alert the buying company of upcoming shipment deliveries. To 
create an ASN or ASBN, select the award shipments being shipped and provide the 
appropriate shipment details.

Note: If you use federal awards, then you can only create ASNs and 
ASBNs only for priced lines and those option lines that have been 
exercised.

The details you can specify on an ASN/ASBN include:

Shipment Lines

• Shipment Line Defaults:

• Packing Slip

• Country of Origin

• Bar Code Label

• Container Number 

• Truck Number

• Comments

• Shipments in Advance Shipment Notices

Note: Click Show or Hide in the Shipments in Advance Shipment 
Notices section to view or hide details.

Shipment Headers 

• Shipment Information (Required fields are marked with *)

• Shipment Number*

• Shipment Date*

• Expected Receipt Date*
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• Freight Information

• Freight Terms

• Number of Containers

• Freight Carrier

• Waybill/Airbill Number

• Bill of Lading

• Packaging Code

• Packing Slip

• Tar Weight

• Special Handling Code

• Net Weight

• Tar Weight UOM

• Comments

• Net Weight UOM

You can enter billing information on a shipment notice to create an ASBN. An ASBN 
creates an invoice in the buyer's payables system. To create an ASBN, in addition to the 
above details, the following billing details should be provided (Required fields are 
marked with *):

• Invoice Number*

• Invoice Amount*

• Invoice Date*

• Payment Terms

• Freight Amount

• Currency

• Tax Amount

• Remit To Site



6-4    Oracle Contract Lifecycle Management for Public Sector iSupplier Portal User Guide

The Advance Shipment Notices section includes:

• Creating Advance Shipment Notices and Advance Shipment Billing Notices, page 
6-4

• Uploading Advance Shipment Notices and Advance Shipment Billing Notices, page
6-6

• Canceling Advance Shipment Notices and Advance Shipment Billing Notices, page 
6-7

Creating Advance Shipment Notices and Advance Shipment Billing 
Notices

You can create advance shipment notices and advance shipment billing notices using 
award shipment lines.

To create advance shipment notices and advance shipment billing notices:

1. Click the Shipments tab, and then click Shipment Notices in the task bar directly 
below the tabs.

2. On the Shipment Notices page, click Create Advance Shipment Notices for an ASN
or Create Advance Shipment Billing Notice for an ASBN.

Note: If you are creating an ASBN, all selected shipments must 
belong to the same operating unit.

3. Select either View Shipments Due This Week or View Shipments Due Any Time, 
and then click Go. Click Advanced Search to enter additional search criteria to 
perform a more restrictive search.

4. Select one or multiple award shipments, and then click Add to Shipment Notice.

Note: For partially funded CLM awards, you can create and ASNs 
or ABSNs to the extent of funded quantity.

5. On the Create Advance Shipment Notice or Create Advance Shipment Billing 
Notice page, enter the appropriate shipment line defaults.

Note: You can always add more shipments by clicking Add 
Shipments on the Shipments Line page.

6. You can enter the CLIN/SLIN line details once for all shipment lines if the details 
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are common to all lines. To copy all default shipment lines, click Default to All 
Lines.

7. To split a shipment line, click the split icon in the Shipments in Advance Shipment 
Notice section, and enter Shipping Quantity for the original and new lines.

8. To remove a shipment click the remove icon in the Shipments in Advance Shipment
Notice section.

Note: To display shipment details, click Show in the Shipment and 
Advance Shipment Notice section. To hide shipment details, click 
Hide in the Shipment and Advance Shipment Notice section.

9. If you would like to enter License Plate Number (LPN), Lot, or Serial Information, 
click the LPN/LOT/serial icon.

You can enter lot and serial information for shipment lines only if you define the item as
a lot or serial controlled item. You will only be able to enter lot information if the item is
lot controlled, serial information if the item is serial controlled, and both lot and serial 
information if your item is a lot and serial controlled.

To enter details for a lot and serial controlled item:

1. Enter lot information. If you would like to add additional lot attributes, click the lot 
attributes icon.

2. If you would like to enter serial details for the lot, click Show, and then enter serial 
information. If you would like to add additional serial attributes, click the serial 
attributes icon.

3. If you have more than one lot or serial controlled item, click Add Another Row. 

4. If you have LPNs nested within each other, enter nesting details in the License Plate
Configuration Details section.

Note: You may change the total shipment quantity on the 
LPN/Lot/Serial Detail page. The total shipment quantity entered 
should be equal to the total lot/serial quantity. 

5. When you are finished entering your LPN/Lot/Serial details, click OK.

6. Click Shipment Headers. Enter the required ASN or ASBN information.

You can also enter other information. The information you enter at the header level 
is transferred to the line level. (However, changes you make at the line level 
override information at the header level). 
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If you are entering an ASBN, you must enter the following billing information:

• Invoice number

• Invoice date

• Invoice amount

In the Remit-To site section, verify that the Remit To Site details are correct. If 
the Remit to Site details need to be changed, click Change, select the correct 
Remit To Site details, and then click Apply.

7. To preview the ASN or ASBN, click Preview.

8. Review the ASN or ASBN and click Submit.

Uploading Advance Shipment Notices and Advance Shipment Billing 
Notices

If you have a large volume of ASNs or ASBNs, you may create a spreadsheet containing
shipment details and upload it into your buying company's system. Using the 
spreadsheet template in iSupplier Portal, you can create shipment notices offline, and 
then upload the file. 

To download instructions on how to upload ASN and ASBNs: 

1. Click the Shipments tab, and then click Shipment Notices in the task bar directly 
below the tabs.

2. Click Upload Advanced Shipment and Billing Notice

3. On the Upload Shipment Notices page, click Download Templates for instructions 
on uploading an ASN or ASBN.

4. On the Download Templates page, choose the file you want to download and click 
Download. You may choose from the following files to download:

• ASN Template and Instructions - Contains instructions for uploading ASNs, a 
sample ASN spreadsheet file, and the template to use when entering ASN 
information offline. 

• ASBN Template and Instructions - Contains instructions for uploading ASBNs, 
a sample ASBN spreadsheet file, and the template to use when entering ASBN 
information offline. 

• Valid List of UOM, freight terms, etc.... - A list of values including country of 
origin, UOM, freight, carriers, payments terms, etc. is provided. You should use
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these values when creating your ASN/ASBN file.

• Zip, All Files - Contains instructions for uploading ASNs, ASBNs, samples of 
ASN and ASBN spreadsheet files, templates to use while entering ASN and 
ASBN information offline, and lists of values.

5. Complete the templates according to the instructions. Save your completed file 
locally. 

6. To upload your template, return to the Upload Shipment Notices page, browse for 
your completed template and upload it. 

Canceling Advance Shipment Notices and Advance Shipment Billing 
Notices

When you cancel an ASN or ASBN, the system sends a notification to the buyer. You 
can always reenter an ASN for the same award shipments later. When you cancel an 
ASBN, the application cancels both the shipment notice and corresponding invoice 
issued in the buyer's payable system.

To cancel a submitted advance shipment notice or advance shipment billing notice: 

1. Click the Shipments tab, and then click Shipment Notices in the task bar directly 
below the tabs.

2. On the Shipment Notices page, click View/Cancel Advance Shipment Notices.

3. On the View/Cancel Advance Shipment Notices page, search for and select the 
advance shipment notice you would like to cancel.

Note: You can use the advanced search feature to narrow your 
search.

4. Click Cancel Shipment Notice. A notification of your cancellation is sent to the 
buyer.

Note: Canceling a shipment notice cannot be undone. An ASN 
cannot be canceled if any of the lines have been received by the 
buying company. You can cancel an ASBN if none of the lines has 
been received and the invoice has not been paid by the buying 
company.
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Uploading Routing Requests
If your buying company is responsible for arranging the packing and shipping of 
materials, you may need to submit a routing request. A routing request notifies your 
buyer when goods are ready for shipment. You may upload a routing request using a 
spreadsheet template. 

To download instructions on how to upload a routing request:

1. Click the Shipments tab, and then click Shipment Notices in the task bar directly 
below the tabs.

2. On the Shipment Notices page, click Create Routing Requests.

3. On the Upload Routing Requests page, click Download Template.

The Readme file included in the download will provide instructions on how to upload 
your routing request.

Viewing Routing Responses
You may view buyer responses to your routing requests. From the Shipment Notices 
page, click View Routing Responses. On the Routing Response page, you may search 
for routing responses (after your buyer has responded to them). You may search using 
the following search criteria:

• Response Number

• Routing Number

• Award Number

• Ship-From

• Ship-To

• Pick Up Time

When you have found the routing response you would like to view, click the response 
number for details. 

Viewing Delivery Schedules
You can use the Delivery Schedules Results  page to quickly determine deliveries that 
need to be scheduled and deliveries that are past due. Click the award number, receipt 
quantity, and ship-to location links to view further detail.
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Viewing Overdue Receipts
The Overdue Receipts Results page enables you to view the details of past due award 
shipments. Click the award number, Ship-To Location, and Buyer to view further detail.

Receiving Information
Receiving information enables you to view your receipts, returns, and delivery 
performance.

The receiving information section includes:

• Viewing Receipts, page 6-9

• Viewing Returns, page 6-10

• Viewing On-Time Delivery Performance, page 6-10

Viewing Receipts
The View Receipts page enables you to explore a historical view of all receipts that 
have been recorded for your shipped goods. 

1. On the View Receipts page, enter a value in one of the search fields to retrieve the 
receipt information. Optionally use the Advanced Search , page 4-4 function to 
specify more complex search criteria. 

2. The View Receipts redisplays, listing the receipts who matched your search 
criteria. 

3. To view the information on a particular receipt, click the receipt number link. 

4. The Receipt: details page displays information on that particular receipt. From this 
page, there are links to display

• ASN/ASBN

• PO information

• Invoice information

• Return information

• On Time Performance information

• Defect information 
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Viewing Returns
The Returns Summary page enables you to view the return history, the causes for 
goods returned by the buying company, and inspection results of a shipment. The 
search summary results include basic information along with details about the return, 
such as quantities and a reason for return. Click Receipt Number and Award Number 
to view further detail.

Viewing On-Time Delivery Performance
The On-Time Performance page provides the delivery status of shipments you made 
against awards. You can view your performance for timeliness of deliveries. Click the 
Award Number and Receipt Number to view further details.

Quality Information
Entering quality information online enables paperless transactions for required quality 
standards. You can only enter quality information if the buying company has Oracle 
Quality and you have permission.

You first create a Quality Collection Plan in Oracle Quality and associate the plan with 
the Self-Service Quality for outside processing transactions. You enter quality 
information to communicate to your buyer if your item meets the quality standards 
required. For example, an electrical motor supplier performs a detailed electrical test on 
each motor. That supplier can enter the quality data gathered from each test and enter 
that information online in Oracle iSupplier Portal before shipping the motor. Quality 
engineers can evaluate the results and stop the shipment of any motors that do not meet
the requirements.

The application displays an available link in the Quality Plans column. Clicking this 
link displays a list of collection plans associated with your award. You can enter quality
results, view quality results submitted, or view attachments for any award listed.

The Quality Shipments page displays award and shipping information for any 
purchased item shipped, but only for open jobs that also have at least one collection 
plan assigned to them. You can obtain the shipment number, ship-to location, and 
ship-to organization. You can also download quality collection plans, and collect and 
submit quality data regarding your shipments.

1. On the Shipments tab, click Quality in the task bar directly below the tabs.

2. On the Search - Quality Shipments page, search for a shipment.

3. Click Available in the Quality Plans column for the appropriate shipment.

4. On the Quality Plans page, click the enter quality results icon. To view existing 
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quality results, click the view quality results icon. To view attachments, click the 
attachment icon.

5. On the Enter Test Results page, enter a number and click Continue. (You can only 
complete this task if you have permission).

6. On the Enter Quality Results page, enter your quality information (the fields 
available to enter data vary depending on the type of information you need to 
enter) and click Submit. You can enter up to 25 rows of quality data at a time.

7. Once you have submitted all of the quality results, a notification is sent to the 
buyer.

To send quality notifications to the buyer or recipient: 

After you have saved and submitted all of your quality results, click Notification to 
notify the buyer or recipient that you have submitted results (if you have permission). 
You can only submit 25 rows of results at a time. If you are submitting more than 25 
rows of results, for example 100 rows of results, you must submit your results four 
times.

Note: To avoid sending duplicate notifications, click Notification only 
after you complete and submit all of your rows of data. 
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7
Planning and Inventory Information

Overview
Oracle iSupplier Portal enables you to view demand forecasts from the buying 
company. Using your item number, you can view different transactions. You can also 
maintain certain item information such as manufacturing and award modifiers. Oracle 
iSupplier Portal enables you to perform vendor managed inventory or track consigned 
inventory stock. You also can maintain your awards and capacity information on the 
application.

This chapter includes the following:

• Forecast Information, page 7-1

• Product Information, page 7-2

• Vendor Managed Inventory, page 7-5

• Consigned Inventory, page 7-6

Forecast Information
Forecast information enables you to view real-time forecasts from the buying company. 
You can view plans, arranged by schedules that communicate expected demand over 
different time horizons. You can see all available schedules and select the schedule 
number to view further details. The Planning tab allows you to view plans that 
communicate forecast information. You can also view forecast schedules. A summary of
schedules displays and you can select each schedule to view details. Click the Schedule 
Number for further information.

The Planning Schedule Summary page displays forecast information for all items. To 
view forecast information for all items on a single page, click the summarized view 
icon. 
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Product Information
Using the Product tab, you can easily access and view information about the products 
you provide sorted by item. 

The product information section includes:

• Viewing Supplier Item Summary, page 7-2

• Viewing Item Inventory Information, page 7-3

• Maintaining Capacity Information, page 7-3

• Maintaining Order Modifiers, page 7-5

Viewing Supplier Item Summary
The Supplier Items page enables you to view all of the details of the products that you 
supply. You can view your search results in a summary format with links on each 
CLIN/SLIN line for:

Awards

A summary of award lines placed with you for this item. This summary includes 
quantity ordered, quantity received, and price break information. Click Award 
Number, Ship-To Location, and Buyer for further information.

Overdue

This contains a summary of overdue receipts for the selected item. Click Award 
Number and Receipt Number for further information.

Receipt History

This contains a summary of receipts for the selected item. Click Award Number and 
Receipt Number for further information.

Defects

This contains a summary view of failed inspection items.

Returns

This contains summary view of returns for an item that includes shipment information, 
RMA number, and quantities. Click Award Number and Receipt Number for further 
information.

On-Time Performance

This contains a summary of receipts for an item that includes due dates, receipt dates, 
and shipping information. Click Award Number and Receipt Number for further 
information.
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Inventory

The On-Hand page provides more details about the item, on-hand quantity, and links 
to both. Revision history and sub-inventory breakdown of the on-hand quantity (with 
locator, lot, and serial).

Vendor Managed Inventory

A summary view of vendor managed items that includes supplier, item shipment 
notice, and buyer information. 

Consigned Inventory

A summary view of consigned items including item, shipment, and transaction 
information. Click the appropriate icon for further information. 

Most of the summaries are available to export.

Viewing Item Inventory Information
The On-Hand Items page enables you to view your item inventory information. 
Viewing your item inventories enables you to view on-hand inventories, item locations, 
lots, and serials.

To view item inventory information: 

1. Click the Product tab, click Supplier Item in the task bar directly below the tabs.

2. Search for an item.

3. On the Supplier Items Result page, select your item and click the inventory icon.

4. Click Revision to view any revisions made to an item.

5. Click the Subinventory icon to view subinventory information for an item.

6. Click the Locator, Lot, or Serial icon to view any specific item information.

7. Click Export to download your inventory information.

Maintaining Capacity Information
You can accurately maintain your delivery capacity online. Your buying company can 
allocate planned awards taking into account your changes to the capacity constraints. 
This provides more accuracy and flexibility in making sourcing allocations during the 
organization's planning, scheduling, and procurement processes.

You can update your capacity abilities for various items for which you are an approved 
supplier. You can use the Order Modifiers page to define processing lead times, fixed 
lot multiples, and minimum order quantities. You can also define tolerance fences by 
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Days in Advance and Tolerance on the Maintain Capacity page. Once your updates are
submitted, the company's buyer is notified and their approved supplier list is updated 
with your information. The company can then better allocate planned awards taking 
allocation and current capacities into account.

You can update the following capacity constraints for each item that has been sourced 
to you:

• Processing lead time

• Order modifiers: minimum order quantity and fixed lot multiple

• Capacity per day for a range of effective date

• Tolerance fences: tolerance percentage and days in advance

After you change capacity information, a notification is sent to the planner and the 
buyer. Based on the preference set by the buying company, the information may go 
through an approval from a buyer or planner. You will be notified of the status of the 
request.

To maintain capacity information: 

1. Click the Product tab, click Maintain Capacity in the task bar directly below the 
tabs.

2. On the Maintain Capacity page, enter search criteria information.

3. Click Search. (You can perform a blind search by clicking Search without entering 
any criteria. This results in all items assigned to you being displayed).

4. Select your item and click Maintain Capacity.

Note: The Maintain Capacity page displays information from 
today's date forward. You can modify the current defined capacity 
or create new entries by clicking Add Another Row.

5. You can also add or modify the Over Capacity Tolerance by changing existing Days
in Advance and Tolerance values.

Note: To add additional Over Capacity Tolerance information, click
Add Another Row.

6. When you have completed your update, click Update Capacity. An Update 
Capacity Confirmation message is displayed.
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Maintaining Order Modifiers
Maintaining award modifiers enables you to view and make changes to the details of 
your ability to fulfill awards scheduled for delivery. You can view shipment processing 
lead times, minimum award quantities, and fixed lot multiples. You can then adjust 
these to fit your delivery ability.

To maintain order modifiers: 

1. Click the Product tab, click Order Modifiers in the task bar directly below the tabs.

2. On the Order Modifiers page, enter search criteria information and click Go.

3. Select your item and click Maintain Order Modifiers.

4. On the Order Modifiers for Item page, you can add or modify the following item 
attribute values:

• Processing Lead Time (in days)

• Minimum Order Quantity

• Fixed Lot Multiple

5. Click Submit.

The item is immediately updated with the changes and an information notification is 
sent to the planning manager or buyer of the item. They can verify your changes in their
approved supplier list.

Note: You can erase any changes before submitting your request by 
clicking Cancel.

Vendor Managed Inventory
Vendor Managed Inventory enables you to manage the inventory at the customer's 
location. Customers can set up the minimum and maximum stock levels required for an
item enabled for maintenance by a supplier.

Using Oracle iSupplier Portal, you can view these minimum and maximum levels and 
also view the current on-hand quantities for that item at the customer location. You 
have the option of triggering the replenishment requests from this page to ensure that 
the stock quantity is maintained at the customer location.

On the Product tab, on the Supplier Item Results page, click the VMI icon. From the 
Vendor Managed Inventory Status page, your search results are displayed with 
detailed information about the status of each item you included in your search and links
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to enter replenishment information. You then initiate replenishment requests for the 
item.

Note: You can save searches that you use frequently by clicking 
Personalize, entering your search criteria, and then saving by clicking 
Apply. Personalize also enables you to customize the information that 
is displayed when you view the VMI Search page.

To generate supply requests:

1. Search for the items you are responsible for. 

2. Review the replenishment method for the item.

3. If the method for the item is Buyer or Supplier Initiates Release; you then select the 
item, enter the quantity, and click Release.

4. If the method for the item is Manual Requisition; you click the enter requisition icon
in the Create Requisition column. On the Enter Order Details page, enter a 
quantity, need-by date, and other details of the order as required by the customer. 

Once you have completed and submitted the replenishment request, you will receive a 
confirmation message that contains the request identifier. You can use the request 
identifier to monitor the progress of your request.

You can override the quantity with either of the manual types of replenishment 
methods. For Automatic Release method items, you can click the enter replenishment 
icon in the Create Requisition column and enter a quantity.

Consigned Inventory
Oracle Procurement along with Discrete Manufacturing supports maintaining 
consigned inventory for an item. Buying companies can enable items to have consigned 
inventory. This enables you to maintain the stock at the buying company location. 
Buying companies do not incur financial liabilities until they start consuming the stock.

Oracle iSupplier Portal enables you to view on-hand stock for consigned items and also 
associated procure-to-pay transactions.

To view consigned items: 

1. Click the Product tab, and then click Consigned Inventory in the task bar directly 
below the tabs.

2. On the Consigned Inventory page, search and select your item.

3. For a given item, suppliers can view the following information:
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• Supplier Item

• Item

• Item Description

• Consigned On-Hand - Displays the on-hand stock levels for the item at the 
buying company. 

• Consigned Shipments - Displays the award shipment details that enable the 
item to be shipped from you to the buying company location.

• Consumption Orders - Displays the awards/blanket releases that are created 
when consigned stock is consumed by the buying company. These are the 
orders against which you can submit invoices to the buying company.

• Consigned Receipts - Displays the history of receipts for consigned stock.

• Consigned Returns - Displays the history of return transactions created for the 
consigned stock.

• Material Transactions - Displays the material transactions that occurred for the 
consigned item. It includes transactions to procure the item, which is the 
consigned stock, and then the transactions to move the stock to regular 
inventory for consumption.

If the consigned item is also enabled for Vendor Managed Inventory, suppliers can 
initiate replenishment requests online.

To view consigned inventory aging items: 

1. Click the Product tab, and then click Consigned Inventory Aging in the task bar 
directly below the tabs.

2. On the Consigned Inventory Aging page, you may search for items that are past 
due, or items that are due in the next 7, 15, or 30 days. Select the appropriate search 
criteria for your item and click Go.

3. For a given item, suppliers can view the following information:

• Supplier Site

• Organization

• Supplier Item

• Item 
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• Item Revision 

• Item Description

• Subinventory

• UOM

• Quantity

• Receipt Date

• Consume Before - Date the item must be consumed. 

• Days Before Consumption is Due - Displays the number of days before the 
ownership of the item is transferred.
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8
Invoice and Payment Information

Overview
You can access invoice and payment information as well as review invoice status online
using Oracle iSupplier Portal. If the buying company uses Oracle Payables, you can also
submit invoices online.

This section includes the following topics:

• Submitting Invoices, page 8-1

• Viewing Invoice Information, page 8-3

• Viewing Payment Information, page 8-6

• Viewing AP AR Netting Report, page 8-5

Submitting Invoices
If your buying company has implemented Oracle Payables, you may submit invoices 
online.

You can submit an invoice online to the buying company based on the award lines you 
have fulfilled. You need to only identify those items shipped and enter a quantity. You 
can invoice against open, approved, standard, or blanket awards that are not fully 
billed. You can enter a credit memo against a fully billed award (use negative quantity 
amounts to enter a credit memo), as well as invoice against multiple awards. However, 
the currency and organization of all items on an invoice must be the same. The 
organization is the entity within the buyer's company that you are invoicing.

You can also partially complete an invoice, save it, and submit it later.

After you submit an invoice, you cannot change the invoice. If you need to make 
adjustments to a submitted invoice, you can create a credit memo against the same 
award items to net out the invoice charges. The award will then be available for a new 
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invoice.

In some cases, there will be no matching award. If you have provided a service, to the 
buying company, for example, landscape services, the buying company may not have 
submitted a formal award. You can submit invoices in these cases as well. 

To submit an invoice with a matching award:

1. Click the Finance tab, and then click Create Invoices in the task bar directly below 
the tabs.

2. On the Invoice Actions page, select either With a PO from the Create Invoice Menu 
and click Go. 

3. On the Create Invoice: awards page, enter search criteria to identify the award, and
click Go.

4. Select items of the PO to be invoiced and click Add to Invoice. Add as many items 
as you need (items on your invoice display at the bottom of the page). If you 
mistakenly add an item to the invoice, you can select it and click Remove from 
invoice.

5. When finished adding items, click Next.

6. On the Create Invoice: Details page, enter an invoice number and remit to address. 
You can also update the quantity and/or price. Enter and any additional 
information, and then click Next. 

7. On the Create Invoice: Manage Tax page, you can view the tax information 
generated. 

8. When finished, click Next.

9. On the Create Invoice: Review and Submit page, review your invoice and click 
Submit. You also have the option to return to this invoice later by clicking Save for 
Later.

10. A Confirmation page is generated informing you of successful invoice creation. .

Creating an Invoice Without an Award

The process of creating invoices that do not have matching awards is similar, although 
some information is not required, and some must be entered. 

The contact information for invoices with awards is restricted to the sites for the users, 
but for invoices without awards, the system will display all contacts for the supplier 
sites to which the user has access.

iSupplier users can enter an invoice without a PO, but if the approval workflow for 
their customer (Oracle Applications user) is not implemented, the status of that invoice 
request will remain IN PROCESS and will not change.
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Note: You need work with the customers to ensure these type of 
invoices are accepted.

To create an invoice without a award: 

1. From the iSupplier Portal  Home  page, click the Finance tab.

2. On the  Create Invoices  page, select Without PO from the Create Invoice menu, 
and click Go. 

3. Enter information as needed. The following fields are required.

• Invoice number

• Remit to name

• Currency

• Customer tax payer ID

Enter any other appropriate information. Use the Items fields to identify and 
describe the item or service for which you are invoicing. When you are finished, 
click Next. 

4. The Review and Submit page shows the tax information generated by the tax 
system. If the invoice information is correct, click Submit.

Viewing Invoice Information
The View Invoices page enables you to search for and view details of an invoice you 
have submitted. You can search using various any or all of the search criteria on the 
page such as: 

• Invoice Number

• Invoice date

• Due date

• Payment status

• Invoice Amount

To view invoice information: 

1. On the iSupplier Portal Home page, click the Finance tab, then click the View 
Invoices subtab.
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2. On the View Invoices page, enter search values into one or more of the search fields,
and click Go. Or use the Advanced Search option. 

3. When the search results display, click the Invoice Number link to view details of the
invoice. (You can also view any associated award(s), payments, scheduled 
payments, or netting report by clicking their respective links, or icons). 

4. On the Invoice Details page, you can see the header level information. 

5. To view invoice line information, click the Invoice Lines tab. You can also view any 
scheduled payments and any hold information.

Note: If you submitted your invoice online, there may be a delay 
before you can review it because the Accounts Payable department 
needs to process it first.

6. In the Payment Information region of Invoice Header, you can view the following 
dispute information for an Invoice:

• Original Invoice Amount

• Dispute Reason

Note:  Oracle Transportation Management (OTM) will pass the 
disputed invoice to Oracle Payables with the original invoice 
amount of the invoice and disputed reasons. Refer the Oracle 
Payables Users Guide for more information on dispute 
resolution setup.

7. You can view the following Netting Information attributes at the header level under
Netting Information:

• Netting Amount

• Reckoning Currency

• Netting Report

Note: You can view the netting attributes only when the profile 
POS: AP AR Netting Information is set as Yes at the User level, or 
the Site level.
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Viewing AP AR Netting Report
Netting functionality of Oracle Payables is integrated with the iSupplier Portal to enable
you to view the netting information for an invoice. Please refer to the Payables and 
Receivables Netting section in the Oracle Payables User's Guide for more information on 
the AP AR Netting set up.

Oracle Payables enables you to offset supplier payables (AP invoice payments) against 
the customer receivables or claims with the netting functionality.

To view the AP AR Netting Report:
1. Navigate to the iSupplier Portal Full Access > Finance> View Invoices. The View 

Invoices page displays.

2. Enter the search criteria for an invoice number and Click Go.

3. Search result displays the invoices matching to your search criteria.

Note:  The Netting Report icon is enabled when the invoice is 
netted off and netting batch is completed, otherwise it is disabled. 
Please refer to the Payables and Receivables Netting section in the 
Oracle Payables User's Guide to know how the invoice is netted off 
and netting batch is completed. 

4. Click the Netting Report icon. The View Netting Report page displays.

5. Select the Final Netting Report item from the Template list.

6. Select the Language from the Locale list. For Example: English: United States (*)

7. Select the Format from the list. You can select the format as Excel, HTML, PDF, and 
RTF from the list.

8. Click Run. The Oracle Netting Report page displays.

9. You can view the following netting information on this page along with invoice 
details:

• Netting Agreement

• Netting Bank Account

• Reckoning Currency

• Final Netting Amount
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Note: You can view the netting information at the Invoice Header 
level, only when the POS: AP AR Netting Information profile is set 
as Yes at the User level, or the Site level.

10. Click Export to save the netting report. 

Viewing Payment Information
Payment inquiry enables you to view the history of all the payments to your invoices 
completed by the buying company. You can use the View Payments page to search 
using various search criteria, including:

• Payment number

• Invoice number

• Payment date

• Award number

To view payment information:

1. On the iSupplier Portal Home page, click the Finance tab, then click the View 
Payments subtab. 

2. On the View Payments page, enter search values into one or more of the search 
fields, and click Go. Or use the Advanced Search option. 

3. When the search results display, click the payment number link to view details of 
the payment. (You can also view any associated award(s), or invoices by clicking 
their links). 

4. On the Payments details page, you can see the payment details including the 
invoices addressed by the payment.
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9
Supplier Profile Management

Overview
Supplier Profile Management enables you to manage key profile details used to 
establish or maintain a business relationship with the buying company. This profile 
information includes address information, names of main contacts, user accounts (if you
have the Supplier Profile and User Management responsibility), business classifications,
banking details, and category information about the goods and services you are able to 
provide to the buyer. Buyer administrators review the details you provide and use them
to update the appropriate records in the buyers' purchasing transaction system.

You benefit from managing your profile yourself. Supplier Profile Management enables 
you to effectively represent yourself to the buying company and update your profile 
details as necessary, making important information accurate.

This section includes the following sections:

• Supplier Profile Management Flow, page 9-1

• Supplier Details, page 9-2

• Address Book, page 9-3

• Contact Directory, page 9-4

• Business Classifications, page 9-5

• Products and Services, page 9-6

• Bank Accounts, page 9-7

Supplier Profile Management Flow
To have the information you enter in Supplier Profile Management processed in the 
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system, log into the Oracle iSupplier Portal and access your profile. You can then enter 
information for your address book, contact directory, business classifications, products 
and services, or user accounts. The buyer administrator will review any changes to your
profile and use this information to update their purchasing system.

General Company Information
Management of your company's profile information involves the use of two high-level 
pages. The General information page provides a quick, high-level display of 
information at the company level. You can use the General information page to add an 
attachment to your profile. Adding attachments enables you to upload documents 
pertinent to your relationship with the buying company or upload documents that the 
buying company may have specifically requested (for example, tax documents).

The Company Organization page allows you to navigate to other pages where you can 
add or update your actual profile information.

To access the General page, on the iSupplier Portal Home page, click the Admin tab.

To upload a local attachment: 

1. Click Add Attachment.

2. To upload an attachment stored locally, accept the default Desktop File/Text/URL 
from the Add menu. 

3. Give the attachment a title, description, and select a Category value to indicate its 
original source 

4. Browse to the location of the attachment and select it.

5. Click Apply. 

To upload an attachment from the buyer's document catalog:

1. Click Add Attachment.

2. Select From Document Catalog from the Add menu. 

3. Search on the document title, or expand the search options to use additional search 
fields. 

4. Select the document(s), and click Apply.

Company Profile
Use the Company Profile pages to define the detailed information about your company.
Use the navigation bar on the left to access the different pages of the Company Profile. 
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The  Organization  page defines high-level details about your company. To access the 
Organization page, click Organization in the Company Profile navigation tree.

Once you have entered appropriate information, click Save.

Tax Details
Using the Payables responsibility ((N) Setup > Options > Payables Options) you can use 
the option to apply the withholding tax at Invoice Validation and Payment or both the 
Invoice Validation and Payment.

The option At Invoice Validation and Payment time has been included. You can select 
this option only if you selected the Use Withholding Tax box in the Withholding Tax 
region of Payables Options and selected the Apply Withholding Tax is selected option 
as the At Invoice Validation and Payment Time. Another option called At Withholding 
Application is added to the Create Withholding Invoice region.

In the Supplier/Supplier Site pages, there are two Lists of Values to display Invoice 
Withholding Tax Group and Payment Withholding Tax Group. At the Supplier level, 
the Allow withholding tax box in tax details tab of the supplier is editable at the 
irrespective of the payables option selected. At the supplier site level the Allow 
withholding tax box is displayed at the supplier site level but is editable only if Use 
Withholding tax box is enabled in the Payables Options of the operating unit to which 
the supplier site is attached and Allow Withholding tax box is selected at the supplier 
level.

Address Book
Use the Address Book page to enter information about Supplier facilities, on your 
company sites. You can create and modify the multiple addresses used in transactions 
with the buying company (for example, purchasing locations, payment sites, and 
addresses for RFQs). You can provide a comment for each address entry to describe 
how it is used. For example, you can enter an address record and indicate the address 
for a location from which you can purchase goods or services.

After you enter address information, the application sends a notification of the changes 
to the buyer administrators. Buyer administrators must review the updates and decide 
how to use the details to update the purchasing system. Therefore, any changes you 
make may not display on the Supplier Home page for a few days.

To manage address book details: 

1. To access the Address Book page, click Address Book in the Company Profile 
navigation tree.

2. The  Address Book  page displays the current addresses defined for your company.
From this page you can 
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• Delete an address by clicking the trash can icon. 

• Update an address by clicking the pencil icon. 

• Add a new address by clicking Create. 

1. On the Create Address page, enter the appropriate information for the new 
address (required fields are marked with an asterisk). 

Note: If Business Classification information is already 
captured against a supplier at the supplier header level, 
then it automatically defaults to any new address you 
create for that supplier. You can modify this information at 
the address level when creating or updating an address. 
However, this will not update the information already 
given at the supplier header level. Once the Business 
Classification information defaults to address level and is 
stored at address level, it cannot default again for existing 
addresses, from the supplier level. All changes have to be 
made at address level only.

2. When finished, click Save.

Contact Directory
The Contact Directory lists the employees at your company who function as contacts 
between you and your buyer.

After entering the contact details, you can link the contacts to the appropriate address 
(described below). As people move within your organization, you can also revise the 
address details for a contact.

You can create multiple contacts and link each one to as many addresses as needed. 
Each contact must be unique based on first name, last name, and phone number. 
Contacts that are obsolete can be removed.

After you enter the information, buyer administrators are notified so they can review 
the details and use then to update their purchasing system. Therefore, your changes 
may not be promoted to the purchasing system for a few days.

Viewing contact information:

1. Click Contact Directory under the Company Profile navigation tree. The system 
displays your current list of contacts.

2. On the Contact Directory page, you can 
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• Delete a contact by clicking the trash can icon.

• Update contact information by clicking the pencil icon.

• View the inactive contacts by expanding the Contact Directory : Inactive 
Contacts region.

• Manage address information for a contact by clicking the Addresses icon. 

Use the Address Associations for Contact page to manage the addresses for a 
particular contact:

• To remove an address for a contact, click the trashcan icon. 

• To add an address to a contact, click Add Another Row, search for the 
address, and click Save.

To create a new contact

1. On the Contact Directory Details page, click Create.

2. Enter the appropriate information for the contact. To create a temporary contact, 
use the pop-up calendar to identify and expiration date. 

3. If you have the authority to create user accounts, the Create User Account for This 
Contact checkbox appears on this page. Clicking this checkbox displays additional 
fields for creating and authorizing users with access to iSupplier Portal..

To create a user account, grant the appropriate responsibilities and specify the 
appropriate user access restrictions to the new user. See the Oracle iSupplier Portal 
Implementation manual for details about defining user accounts. 

4. Once you have specified your contact (and user account, if applicable) information, 
click Save. 

Business Classifications
Buying companies establish a list of business classifications they want to use to classify 
their supply base. In some regions, these classifications are required by government 
regulations.

You can claim classifications that are appropriate to your business and add any 
required classification details. Buyers can then audit your qualifications. Once you 
claim the appropriate classifications, buyer administrators are notified so they can 
review the details.

Designated supplier users will be notified when the re-certification date for supplier's 
business classification is due. This is for the re-certification of the business classification 
and is based on the Business Classification Re-Certification Notification Reminder Days 
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profile option set by the system administrator.

You can define the relevant business type or socio-economic classifications for each 
vendor. The classification includes the two-character prefix ID for the Central 
Contracting Registry (CCR) code. The CCR is a central database containing basic 
business information where all vendors wishing to do business with the federal 
government under a FAR-based contract must be registered before being awarded a 
contract. As an administrator, you need to certify the classification, select if the 
classification is applicable, select the minority type, if applicable, the certificate number, 
certifying agency, and the expiration date and click Save.

To claim / re-certify business classifications:

1. On the Admin  information page, click Business Classifications.

2. On the Business Classifications page, check Applicable check box for all 
classifications that apply to your company. 

Note: It is possible that two sites, using the same address can have 
different business classifications.

3. Select the "I certify, that I have reviewed the classification below and they are 
current and accurate" check box.

Note: Even if this check box is not selected the business 
classification is recertified when you click Save.

4. Complete the remaining fields.

5. Click Save. The Business Classification is updated.

Products and Services
Buying companies define product and service category sets that they use to categorize 
their supply base. You can browse the list of goods and services and select all those that 
apply to your business. Buying companies can then use this information; some may use 
it to help generate supplier invitation lists for RFQs or for reporting.

You can browse the hierarchy tree and select a parent category or child categories. 
When a parent is selected, the buying company assumes that you can provide all the 
products or services in that category. After you select the product and services 
categories that apply to your business, buyer administrators are notified so they can 
review the details. You can update your selections at any time.

A supplier or supplier profile management administrator can search for a specific 
product or service from the Product & Services hierarchy. Supplier administrator can 
view the validation code corresponding to the respective product or service on the Add 
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Products and Services page. Suppliers can view the search results with:

• Products and Services codes along with Description.

• List of Product and Services ordered by Description.

You can search for the products and services in the Prospective Supplier Registration: 
Additional Details page, Prospective Supplier Registration: Add Product and Services 
page, Supplier Profile Change Request page, and Product and Services Subcategories 
page.

To claim, or search for products and services:

1. On the Admin information page, click Product and Services.

2. On the Products and Services page, the system displays the list of categories with 
their codes, and approval status that have already been claimed by your company. 
(To browse child category details for any parent, click the view sub-category icon.)

3. Click Add. The Add Products and Services page displays.

4. In the Add Products and Service page, the supplier user can search for products 
and services with the Browse All Products & Services default option, or select the 
Search for Specific Product & Services option to enter the search criteria for code, 
description, or a combination of both and click Go. 

5. You can view the search results for products and services ordered by description.

6. Select the Applicable check box. (Applicable check box is greyed out for products or
services which are already selected as Applicable.)

7. Click Apply.

8. To view sub-category information about a product or service, click the view 
sub-categories icon. On the Add Products and Services page, click Applicable to 
apply a particular sub-category, and then click Apply.

To remove products or services:

1. On the Products and Services page, select a product or service.

2. Click Remove.

Banking Details
To simplify the process of capturing bank account related details and to improve data 
quality, you can create and maintain your own bank account details and assign these 
accounts to multiple addresses within your company. Buying companies can then 
access and approve these details for propagation into their payables systems. 
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You can create and maintain bank account details that you want the buying company to
use when they make payments to you. The system captures all relevant information. 
Since bank accounts are defined for a particular bank, branch and account number, you 
have the ability to enter all this information when creating your account entries. When 
you enter your account information, the system validates for duplicate entries.

Responding to Buyer Surveys
From time to time, buyers may request you respond to surveys. Surveys are used by the
buying organizations to solicit information and input for use in improving relationships
with suppliers. 

To respond to a buyer survey: 

1. From the iSupplier Portal Home page, click the Admin tab. 

2. On the General page, click Surveys in the navigation tree on the left. 

3. All surveys appropriate for you are listed in the table. To respond to a survey, click 
the pencil icon. The instructions on completing surveys vary from one to another.
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10
Buying Company View

Buying Company Views
The buying company view provides the same easy to use view of procure-to-pay 
transactions as the supplier view. Using the Internal User View responsibility in Oracle 
iSupplier Portal, your buying company can view award, shipment, receipt, invoice, and 
payment information. They can also search for information across all suppliers, as well 
as respond to supplier change requests. 

This section includes information for buying companies using Oracle iSupplier Portal, 
and includes the following:

• Using the Oracle iSupplier Portal Home Page with the Buying Company View, 
page 10-1

• Award Information, page 10-2

• Shipment Notices, page 10-6

• Invoices, page 10-7

Using the Oracle iSupplier Portal Home Page with the Buying Company 
View

When you access the Oracle iSupplier Portal application using the Internal User View 
responsibility, the Oracle iSupplier Portal home page displays.

This page provides the following information:

Global buttons

The following buttons display on the home page and all Oracle iSupplier Portal pages:

Home - Returns you to the main portal where you can select another responsibility or 
application
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Logout

Preferences - Displays the Preferences page

Tabs

Oracle iSupplier Portal provides tabs for easy navigation. For example, if you want to 
view of a award, start by clicking the Orders tab, and then click an order type in the 
task bar directly below the tabs.

Quick Links

This section displays direct links to various functionality in the Oracle iSupplier Portal 
application. Click any link to go directly to the corresponding page.

Notifications

To view notifications, click the linked subject. Notifications are messages that you may 
respond to. For example, a supplier may have submitted a change request and is 
waiting for you to respond to (accept) it. 

Awards at a Glance

To view your most recent orders, click an award number.

Modifications at a Glance

To view your most recent modifications, click a modification number.

Pending Change Requests

To respond to supplier change requests, click an award number.

Award Information
For more information, please refer to the CLM for Public Sector Implementation Guide.

Awards
The Awards page enables you to view and search for awards.

Some examples of fields for you to enter search criteria include: 

• Operating Unit

• Award Number

• Order Date

• Supplier

• Supplier Site

• Buyer
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You must enter minimum search criteria to display search results. Minimum search 
criteria for awards include operating unit and award number or supplier.

Using advanced search, you can build and narrow searches with the available search 
operators. Search operators enable you to specify the matching conditions for a search. 
Available search operators include:

• is - Use this operator for an exact match.

After you have entered you search criteria, click Go. 

Once your search criteria displays, you may view details of awards in the awards list.

If you would like to export data regarding awards, click Export.

To view the details of an award, click the award number link.

The View Award Details displays the details of the award. Use the Actions menu 
options to view further details for the award. Note also that you can create a work 
confirmation for this award by selecting Create Work Confirmation from the Actions 
menu.

IDVs
The IDVs page enables you to view and search for supplier IDV details.

You may search for details on supplier IDV using the following search criteria:

• Operating Unit

• Award Number

• Supplier

• Supplier Site

• Global 

• Effective From Date

• Effective To Date

• Status

You must enter minimum search criteria to display search results. Minimum search 
criteria for agreements include operating unit and Award Number or supplier.

You may view details of supplier agreements in the search results list.

If you would like to export data regarding supplier agreements, click Export.
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Purchase History
The Award Revision History page enables you to view and search for purchase history 
details.

You may search for details on award revision histories using the following search 
criteria:

• Business Unit

• Award Number

• Release Number

• Supplier

• Revision

• Supplier Site

• Document Type

• Creation Date

• Revised Date

You must enter minimum search criteria to display search results. Minimum search 
criteria for purchase history include business unit and Award number or supplier.

You may view details of award revision histories in the search results list.

If you would like to export data regarding award revision histories, click Export.

Acknowledging Changes
Note: The Acknowledging Changes feature is not available for CLM 
awards.

Over the lifecycle of an award, the supplier may communicate changes to values on the 
award. These changes could be changes to the award values themselves. If the award 
represents a complex work project, the supplies may need to bill you at interim points 
during the life of the contract. In these cases, the supplier will create a work 
confirmation to notify you upon achievement of a certain milestone, or performance of 
a certain completion percentage. In either case, you need to acknowledge the change.

Route Change Requests to Requester

Buying organizations can route supplier change requests to the requester for approval. 
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You can create a routing rule based on any combination of these attributes: promised 
date, shipment quantity, and price for non-catalog items. Using a Purchasing 
responsibility, navigate to Setup > Tolerance and Routing > Supplier Change Award.

The application routes supplier change requests that meet predefined rules to the 
requester for approval. When the requester does not have the appropriate approval 
authorization, the approval of the requester's approval hierarchy is required.

To acknowledge award change requests:

The Change Requests page enables you to view awards with outstanding change 
requests as well as awards rejected by suppliers.

To view a list of awards that suppliers have rejected, select Supplier Acknowledgement 
Rejections from the View menu and click Go.

To respond to supplier change requests:

1. From the iSupplier Portal Home page, click the Awards tab, and then click the 
Pending Changes subtab.

2. Select Change Requests Pending Response from the View menu and click Go.

3. Select the award whose changes you wish to approve/reject, and click Respond to 
Changes.

4. On the  Respond to Supplier Changes  page, the values for the award lines that 
have been changed by the supplier are displayed in the PO Details section. For any 
value that has changed, you can see the previous value and the new value, flagged 
with a green star. 

5. To accept all the changes, click Accept All. To reject all changes, click Reject All.

6. Otherwise, for any changes you wish to address, select Accept or Reject from the 
Response menu. You can also enter text documentation in the Reason column. 
When finished, click Submit.

7. You will receive confirmation that your response to changes has been submitted.

To acknowledge a work confirmation:

1. On the Awards tab, click the Work Confirmations subtab. 

2. On the Work Confirmations page, select Work Confirmations to Approve from the 
View menu and click Go. 

3. Select the work confirmation you wish to view and click Respond. 

4. The work confirmation may include one or more pay items for approval. Select the 
appropriate action from the Response menu. You can enter a note to the supplier (if 
you reject a pay item, a reason is required). 
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5. When finished replying to the pay items on the work confirmation, click Submit. 

Shipment Information
The shipment information tab contains alerts and information about upcoming 
shipments and receipts and payments.

Shipment Notices
On the View Advance Shipment Notices page, you may search for details on advance 
shipment notices using the following search criteria:

• Shipment Number

• Supplier

• Supplier Site

You must enter a minimum search criteria to display search results. Minimum search 
criteria for shipment notices include shipment number or supplier.

You may view details of shipment notices in the search results list.

If you would like to export data regarding shipment notices, click Export.

Receipts
On the Receipt Transactions page, you may search for details on receipt transactions 
using the following search criteria:

• Organization

• Supplier

• Supplier Site

• Receipt Number

• Receipt Date

• Award Number

• Item

• Supplier Item 

• Receipt Location
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You must enter a minimum search criteria to display search results. Minimum search 
criteria for receipts include receipt or supplier.

You may view details of receipt transactions in the search results list.

If you would like to export data regarding receipt transactions, click Export.

Account Information
The account information section contains information about invoices and payments.

Invoices
On the View Invoices page, you may search for details on invoices using the following 
search criteria:

• Invoice 

• Supplier

• Supplier Site

• Invoice Date

• Award Number

• Payment

• Packing Slip

• Payment Status

• Operating Unit

• Gross Amount

• Invoice Date

• Amount Due

• Due Date

You must enter a minimum search criteria to display search results. Minimum search 
criteria for invoices include invoice number or supplier.

You may view details of invoices in the search results list.

If you would like to export data regarding invoices, click Export.
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Payments
On the View Payments page, you may search for payment summaries using the 
following search criteria:

• Payment

• Supplier

• Supplier Site

• Payment Date

• Award Number

• Packing Slip

• Operating Unit

• Payment Amount

• Payment Date

You must enter a minimum search criteria to display search results. Minimum search 
criteria for payments include payment number or supplier.

You may view payment details in the search results list.

If you would like to export data regarding payments, click Export.

Tolerance Based Auto-Approval
Buying organizations can filter supplier change order requests and auto-approve them 
based on predefined supplier change order tolerances. These tolerances can be set at 
Operating Unit level. 

Supplier change order requests that fall within tolerance limits are automatically 
approved. The buyer is notified when a change request is auto-approved but does not 
need to take any action.

Use a Purchasing responsibility where you can use the Setup option. Navigate to Setup 
> Tolerance and Routing > Supplier Change Order.

Select an operating unit and click the Go button.

• In the Buyer Auto-Acceptance Tolerance table, you can find that each attribute has 
both Maximum Increment and Maximum Decrement entries. By default, all are set 
to 0.
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• You can find the table has more attributes than the ones suppliers can change, like 
Document, line, and shipment amounts. These attributes will be altered if supplier 
initiates changes to shipment qty or line price. The system will check against not 
only the values directly changed by the supplier, but also the values altered by the 
changes.

• For some attributes, like Document Amount or Line Amount, tolerance can be set 
up for both % and dollar values, If only one, say %, is set up, the system will check 
against the % value. If both % and dollar value are set up, the system will take the 
more restrictive attribute that is applicable to the change order.

Click the Save button to complete the tolerance setup.
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A
Pages and Navigation Paths

Use the iSupplier Portal Internal View or the iSupplier Portal Full Access responsibility.

Legends

The following legends indicate the objects in the navigation paths:

• (H) – Hyperlink 

• (T) – Tab 

• (ST) – Sub-Tab

• (B) – Button 

• (LOV) – List of Values

ISUPPLIER PORTAL USING 

Home 
1. iSupplier Portal Internal View > Home

Awards
1. iSupplier Portal Internal View > (T) Awards

Award Details
1. iSupplier Portal Internal View > (T) Awards

Click Award Number Link.
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Shipments
1. iSupplier Portal Internal View > (T) Shipments

Finance
1. iSupplier Portal Internal View > (T) Finance

Search for CLM documents by number
1. Home > Select a value from the Search LOV

• Award Number

• Shipment Number

• Invoice Number 

• Payment Number

• Modification Number

Click (B) Go

Viewing Notifications using seeded views
1. Home > (T) Notifications

2. Select a view from the View LOV and click (B) Go.

• Open Notifications

• FYI Notifications

• Open Notifications from me

• Notifications To Do

View Full List
1. Home > (T) Notifications > (B) Full List
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Open Notifications
1. Select a notification and click (B) Open

Reassign Notifications
1. Select a notification and click (B) Reassign

Request Information 
1. Select a notification and click (B) Open

2. Select (B) Request Information

Awards at a Glance
1. Home > Awards at a Glance

Pending Change Requests
1. Home > Pending Change Requests

Modifications At A Glance 
1. Home > Modifications At A Glance

Awards
1. Awards > (ST) Awards

Search Awards
1. Awards > (ST) Awards

2. Specify the search criteria and click (B) Go
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Advanced Search
1. Awards > (ST) Awards > (B) Advanced Search

Actions on Awards
1. Awards > (ST) Awards

2. Select an award and then select an Action from the Select Award LOV

• View Change History 

• Respond to Changes

Export Awards
1. Awards > (ST) Awards > Export

IDVs
1. Awards > (ST) IDVs

Search IDVs
1. Awards > (ST) IDVs

2. Specify the search criteria and click (B) Go

Advanced Search IDVs
1. Awards > (ST) IDVs > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Awards > (ST) IDVs 

2. Select another search criteria by using the Add Another LOV > (B) Add
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Export IDVs
1. Awards > (ST) IDVs > (B) Export

Work Confirmations
1. Awards > (ST) Work Confirmations

Search Work Confirmations
1. Awards > (ST) Work Confirmations > Search

2. Specify the search criteria and click (B) Go

Advanced Search
1. Awards > (ST) Work Confirmations > (B) Advanced Search

2. Specify the search criteria and click (B) Go

Export Work Confirmations
1. Awards > (ST) Work Confirmations > (B) Export

Pending Changes
1. Awards > (ST) Pending Changes

Search Change Requests
1. Awards > (ST) Pending Changes > Search

2. Specify the search criteria and click (B) Go

View Change Requests
1. Awards > (ST) Pending Changes > View
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2. Select an option from the View LOV

Export Change Requests
1. Awards > (ST) Pending Changes > Export

Respond to Changes
1. Awards > (ST) Pending Changes > Change Requests

2. Select an award

3. Click (B) Respond to Change

View Change History
1. Awards > (ST) Pending Changes > Change Requests

2. Select an award and click (B) Respond to Change

3. Click (B) View Change History to view the history of changes for this award

Accept All Change Requests
1. Awards > (ST) Pending Changes > Change Requests

2. Select an award and click (B) Respond to Change

3. Click (B) View Change History to view the history of changes for this award

Reject All Change Requests
1. Awards > (ST) Pending Changes > Change Requests

2. Select an award and click (B) Respond to Change

3. Click View Change History button to view the history of changes for this award.

4. Click (B) Reject All
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Submit Change Requests
1. Awards > (ST) Pending Changes > Change Requests

2. Select an award and click (B) Respond to Change

3. Click View Change History button to view the history of a changes for this award.

4. Click Submit

Modifications
1. Awards > (ST) Modifications

Search Modifications
1. Awards > (ST) Modifications > Search

2. Specify the search criteria and click (B) Go

Advanced Search
1. Awards > (ST) Modifications > (B) Advanced Search

2. Specify the search criteria and click (B)

Add another search criteria by using the Add Another LOV
1. Awards > (ST) Modifications > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV. Click (B) Add

Export Modifications
1. Awards > (ST) Modifications > (B) Export

Shipment Notices
1. Shipments > (ST) Shipment Notices
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View Advance Shipment Notices
1. Shipments > (ST) Shipment Notices

Search Shipment Notices
1. Shipments > (ST) Shipment Notices > Search

2. Specify the search criteria and click (B) Go

Advanced Search
1. Shipments > (ST) Shipment Notices > (B) Advanced Search

2. Specify the search criteria and click (B) Go

Export Shipment Notices
1. Shipments > (ST) Shipment Notices > (B) Export

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Shipment Notices > (B) Advanced Search

2. Specify another search criteria by using the Add Another LOV

3. Click (B) Add

Receipts
1. Shipments > (ST) Receipts

Search Receipts
1. Shipments > (ST) Receipts > Search

2. Specify the search criteria and click (B) Go
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Advanced Search
1. Shipments > (ST) Receipts > (B) Advanced Search

2. Specify the search criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Receipts > (B) Advanced Search

2. Specify another search criteria by using the Add Another LOV

3. Click (B) Add

Export Receipts
1. Shipments > (ST) Receipts > (B) Export

View Invoices
1. Finance > (ST) View Invoices

Search Invoices
1. Finance > (ST) View Invoices > Search

2. Specify the search criteria and click (B) Go

Advanced Search
1. Finance > (ST) View Invoices > (B) Advanced Search

2. Specify the search criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Finance > (ST) View Invoices > (B) Advanced Search

2. Specify another search criteria by using the Add Another LOV
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3. Click (B) Add

Export Invoices
1. Finance > (ST) View Invoices > (B) Export

View Payments
1. Finance > (ST) View Payments

Search Payments
1. Finance > (ST) View Payments > Search

2. Specify the search criteria and click (B) Go

Advanced Search
1. Finance > (ST) View Payments > (B) Advanced Search

2. Specify the search criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Finance > (ST) View Payments > (B) Advanced Search

2. Specify another search criteria by using the Add Another LOV

3. Click (B) Add

Export Payments
1. Finance > (ST) View Payments > (B) Export
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ISUPPLIER PORTAL USING FULL ACCESS

Home 
1. iSupplier Portal Full Access > Home

Awards
1. iSupplier Portal Full Access > (T) Awards

Shipment 
1. iSupplier Portal Full Access > Shipment

Planning
1. iSupplier Portal Full Access > Planning

Finance 
1. iSupplier Portal Full Access > Finance

Product
1. iSupplier Portal Full Access > Product

Admin
1. iSupplier Portal Full Access > Admin

Search for a document using the document number
1. iSupplier Portal Full Access > Home

2. Select an option from the Search LOV and click (B) Go

• Award Number
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• Shipment Number

• Invoice Number

• Payment Number

• Modification Number

Notifications
1. Home > Notifications

Awards at a Glance
1. Home > Awards at a Glance

Modifications at a Glance
1. Home > Modifications at a Glance

View using seeded options
1. Select an option from View LOV and click (B) Go

• All Notifications

• FYI Notifications

• Open Notifications

• To Do Notifications

Open Notifications
1. Select a notification.

2. Click (B) Open.
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Reassign Notifications 
1. Select a notification. 

2. Click (B) Reassign.

Request Information 
1. Select a notification.

2. Click (B) Request Information

Awards 
1. Awards > (ST) Awards

Search Awards
1. Awards > (ST) Awards > Search

2. Specify search criteria and click (B) Go

Advanced Search
1. Awards > (ST) Awards > (B) Advanced Search

2. Specify search criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Awards > (ST) Awards

2. Select another search criteria by using the Add Another LOV > (B) Add

Multiple Awards Change
1. Awards > (ST) Awards > (B) Multiple Awards Change
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Actions on Awards
1. Awards > (ST) Awards 

2. Select an order and then select an Action from the Select Order LOV 

• View Change History

Export Awards
1. Awards > (ST) Awards > (B) Export

Work Orders
1. Awards > (ST) Work Orders

Search Work Orders 
1. Awards > (ST) Work Orders > Search

2. Specify the criterion and click (B) Go

Reschedule Work Orders 
1. Awards > (ST) Work Orders

2. Select an object and click (B) Reschedule

IDVs
1. Awards > (ST) IDVs

Search Supplier IDVs
1. Awards > (ST) IDVs > Search

2. Specify the criteria and click (B) Go
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Advanced Search
1. Awards > (ST) IDVs > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Awards > (ST) IDVs

2. Select another search criteria by using the Add Another LOV > (B) Add

Export Supplier IDVs
1. Awards > (ST) IDVs

2. Search for agreements, select and click (B) Export

Purchase History 
1. Awards > (ST) Purchase History

Work Confirmations
1. Awards > (ST) Work Confirmations 

Search Award Purchase History 
1. Awards > (ST) Purchase History > Search 

2. Specify the criteria and click (B) Go

Export Award Purchase History 
1. Awards > (ST) Purchase History > (B) Export

View Work Confirmations using seeded views
1. Select one of following options:
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• Last 25 Work Confirmations 

• Draft Work Confirmations

• Rejected Work Confirmations

• All Work Confirmations

Update Work Confirmations
1. Awards > (ST) Work Confirmations

2. Search for work confirmations using the seeded views from View LOV

3. Select the work confirmation

4. Click (B) Update

Advanced Search Work Confirmations
1. Awards > (ST) Work Confirmations > (B) Advanced Search

2. Specify the criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Awards > (ST) Work Confirmations 

2. Select another search criteria by using the Add Another LOV > (B) Add

Export Work Confirmations
1. Awards > (ST) Work Confirmations > (B) Export

RFQ (Request for Quotations) 
1. Awards > (ST) RFQ
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Search RFQs Awards > (ST) RFQ > Search 
1. Specify the criteria and click (B) Go

Advanced Search for RFQ 
1. Awards > (ST) RFQ > (B) Advanced Search 

2. Specify the criteria and click (B) Go

Add another search criteria by using the Add Another LOV 
1. Awards > (ST) RFQ

2. Select another search criteria by using the Add Another LOV > (B) Add

Export RFQ Summary 
1. Awards > (ST) RFQ > (B) Export

Deliverables 
1. Awards > (ST) Deliverables

Search Deliverables 
1. Awards > (ST) Deliverables > Search 

2. Specify the criteria and click (B) Go

Time Cards
1. Awards > (ST) Time Cards

Search Time Cards 
1. Awards > (ST) Time Cards > Search 
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2. Specify the criteria and click (B) Go

Advanced Search for Time Cards
1. Awards > (ST) Time Cards > (B) Advanced Search

2. Specify the criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Awards > (ST) Time Cards

2. Select another search criteria by using the Add Another LOV > (B) Add

Export Time Cards
1. Awards > (ST) Time Cards > (B) Export

Modifications
1. Awards > (ST) Modifications

Search Modifications 
1. Awards > (ST) Modifications > Search 

2. Specify the criteria and click (B) Go

Advanced Search for Modifications
1. Awards > (ST) Modifications > (B) Advanced Search

2. Specify the criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Awards > (ST) Modifications

2. Select another search criteria by using the Add Another LOV > (B) Add
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Export Modifications
1. Awards > (ST) Modifications > (B) Export

Delivery Schedules
1. Shipments > (ST) Delivery Schedules

Search Delivery Schedules
1. Shipments > (ST) Delivery Schedules > Search

2. Specify the criteria and click (B) Go

Advanced Search for Delivery Schedules 
1. Shipments > (ST) Delivery Schedules > (B) Advanced Search

2. Specify the criteria and click (B) Go

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Delivery Schedules

2. Select another search criteria by using the Add Another LOV > (B) Add

Export Delivery Schedules
1. Shipments > (ST) Delivery Schedules > (B) Export

Shipment Notices
1. Shipments > (ST) Shipment Notices

Create Advance Shipment Notice
1. Shipments > (ST) Shipment Notices 
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2. Click (H) Create Advance Shipment Notice

Create Advance Shipment Billing Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) Create Advance Shipment Billing Notices

Upload Advance Shipment and Billing Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) Upload Advance Shipment and Billing Notices

View / Cancel Advance Shipment and Billing Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) View/Cancel Advance Shipment and Billing Notices

View Advance Shipment Notice using seeded views
1. Shipments > (ST) Shipment Notices

2. Click (H) Create Advance Shipment Notices

3. Select a value from the View LOV

• Shipments due this week

• Shipments due anytime

4. Click (B) Go

Advanced Search for Advance Shipment Notice
1. Shipments > (ST) Shipment Notices > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Shipment Notices (B) Advanced Search
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2. Select another search criteria by using the Add Another LOV 

3. Click (B) Add

View Advance Shipment Billing Notices using seeded views
1. Shipments > (ST) Shipment Notices

2. Click (H) Create Advance Shipment Billing Notices

3. Select a value from the View LOV

• Shipments due this week

• Shipments due anytime

4. Click (B) Go

Advanced Search for Advance Shipment Billing Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) Create Advance Shipment Billing Notices

3. Click (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Shipment Notices

2. Click (H) Create Advance Shipment Billing Notices 

3. Click (B) Advanced Search

4. Select another search criteria by using the Add Another LOV 

5. Click (B) Add

Personalize Upload Advance Shipment and Billing Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) Upload Advance Shipment and Billing Notices
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3. Click (H) Personalize Upload Advance Shipment and Billing Notices

Upload Shipment Notices
1. Shipments > (ST) Shipment Notices

2. Click (H) Upload Advance Shipment and Billing Notices

3. Click (H) Upload Shipment Notices in the left pane

4. Browse and choose a file

5. Click (B) Start Load Now

Download Templates
1. Shipments > (ST) Shipment Notices

2. Click (H) Upload Advance Shipment and Billing Notices

3. Click (H) Download Templates in the left pane

4. Choose a file and click (B) Download

View Load Status
1. Shipments > (ST) Shipment Notices 

2. Click (H) Upload Advance Shipment and Billing Notices 

3. Click (H) View Load Status in the left pane

View Load Status using seeded views 
1. Shipments > (ST) Shipment Notices 

2. Click (H) Upload Advance Shipment and Billing Notices 

3. Click (H) View Load Status in the left pane 

4. Select the view using View LOV

• All requests
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• Successful requests 

• Requests with error

5. Click (B) Go

Personalize View Load Status
1. Shipments > (ST) Shipment Notices 

2. Click (H) Upload Advance Shipment and Billing Notices 

3. Click (H) View Load Status in the left pane 

4. Click (H) Personalize View Load Status

Search View Advance Shipment Notices
1. Shipments > (ST) Shipment Notices 

2. Click (H) View / Cancel Advance Shipment and Billing Notices 

3. Specify the search criteria and click (B) Go

Advanced Search for Advance Shipment Notices
1. Shipments > (ST) Shipment Notices 

2. Click (H) View / Cancel Advance Shipment and Billing Notices 

3. Click (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Shipment Notices 

2. Click (H) View / Cancel Advance Shipment and Billing Notices 

3. Click (B) Advanced Search Select another search criteria by using the Add Another 
LOV 

4. Click (B) Add
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Export Advance Shipment Notice
1. Shipments > (ST) Shipment Notices

2. Click (H) View / Cancel Advance Shipment and Billing Notices > (B) Export

View Shipment Schedules
1. Shipments > (ST) Shipment Schedules

Search Shipment Schedules Summary
1. Shipments > (ST) Shipment Schedules > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Shipment Schedules Summary
1. Shipments > (ST) Shipment Schedules > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Shipment Schedules > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV 

3. Click (B) Add

Export Shipment Schedules Summary
1. Shipments > (ST) Shipment Schedules > (B) Export

View Receipts
1. Shipments > (ST) Receipts
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Search Receipts
1. Shipments > (ST) Receipts > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Receipts
1. Shipments > (ST) Receipts > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Receipts > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV 

Export Receipts
1. Shipments > (ST) Receipts > (B) Export

Returns Summary
1. Shipments > (ST) Returns

Search Returns Summary
1. Shipments > (ST) Returns > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Returns Summary 
1. Shipments > (ST) Returns > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Returns > (B) Advanced Search
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Select another search criteria by using the Add Another LOV 
1. Shipments > (ST) Returns > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV 

3. Click (B) Add

Export Returns Summary
1. Shipments > (ST) Receipts > (B) Export

View Overdue Receipts
1. Shipments > (ST) Overdue Receipts

Search Overdue Receipts
1. Shipments > (ST) Overdue Receipts > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Overdue Receipts 
1. Shipments > (ST) Overdue Receipts > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Overdue Receipts > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV

3. Click (B) Add

Export Overdue Receipts
1. Shipments > (ST) Overdue Receipts > (B) Export
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On-time Performance
1. Shipments > (ST) On-time Performance

Search On-time Performance
1. Shipments > (ST) On-time Performance > Search

2. Specify the search criteria and click (B) Go

Advanced Search for On-time Performance 
1. Shipments > (ST) On-time Performance > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) On-time Performance > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV 

3. Click (B) Add

Export On-time Performance
1. Shipments > (ST) On-time Performance > (B) Export

Quality Shipments
1. Shipments > (ST) Quality

Search Quality Shipments
1. Shipments > (ST) Quality > Search

2. Specify the search criteria and click (B) Go
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Advanced Search for Quality Shipments 
1. Shipments > (ST) Quality > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (ST) Quality > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV

3. Click (B) Add

Export Quality Shipments
1. Shipments > (ST) Quality > (B) Export

View Planning Schedule Summary
1. iSupplier F > (T) Planning 

Search Planning Schedule Summary
1. Shipments > (T) Planning > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Planning Schedule Summary 
1. Shipments > (T) Planning > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Shipments > (T) Planning > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV 

3. Click (B) Add
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Export Planning Schedule Summary
1. Shipments > (T) Planning > (B) Export

Create Invoices
1. Finance > (ST) Create Invoices

2. Select the following option from the Create Invoice LOV

• With a PO

• Without a PO

3. Click (B) Go

Search Invoices
1. Finance > (ST) Create Invoices > Search

2. Specify the search criteria and click (B) Go

View Invoices
1. Finance > (ST) View Invoices

Search Invoices
1. Finance > (ST) View Invoices > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Invoices 
1. Finance > (ST) View Invoices > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Finance > (ST) View Invoices > (B) Advanced Search
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2. Select another search criteria by using the Add Another LOV

3. Click (B) Add

Export Invoices
1. Finance > (ST) View Invoices > (B) Export

View Payments
1. Finance > (ST) View Payments

Search Payments
1. Finance > (ST) View Payments > Search

2. Specify the search criteria and click (B) Go

Advanced Search for Payments 
1. Finance > (ST) View Payments > (B) Advanced Search

Add another search criteria by using the Add Another LOV
1. Finance > (ST) View Payments > (B) Advanced Search

2. Select another search criteria by using the Add Another LOV

3. Click (B) Add

Export Payments
1. Finance > (ST) View Payments > (B) Export

View Payments
1. Finance > (ST) View Payments
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Glossary

Abbreviated Classification

A one or two letter representation of the Classification, i.e. C, S, TS, and U.

Abstract of Offers

The record of all bids received on a sealed bid solicitation or in response to a negotiation
solicitation. Data similar to SF 1409 or SF 1410.

Accounting Classification Reference Number (ACRN)

A two position alpha or alpha/numeric control code used as a method of relating the 
accounting classification citation to detailed line item information contained in the 
schedule of a contract.

Acquisition Action Request (AAR)

A formal and official request, in either electronic or hard-copy form, from a requiring 
entity to an acquisition office for the procurement of supplies or services or for the 
modification of a request submitted previously.

Address Type

A designation of government office such as: Additional POC, Contracting Officer's 
Representative (COTR), Administration Office (Admin), Invoice Office, Issuing Office, 
Delivery Office, Property Office, Order Office, Payment Office, Request Office, 
Technical Office, Place of Performance, and Small Business Administration Office.

Administration Contracting Office (ACO)

The Administration Contracting Office (ACO) is the office that is responsible for 
administering contracts. 

Administrative Change

A contract modification that does not affect the substantive rights of the parties (e.g., a 
change in the paying office or the appropriation data).
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Agreement

Term used to describe the following types of agreements: Basic Agreements, Basic 
Ordering Agreements, and Blanket Purchase Agreements. 

Amendment

A procurement vehicle created for the purpose of adding, changing, or deleting data on 
a processed Purchase Request or Solicitation. 

Amendment Control Number 

A unique temporary supplemental PIIN that is assigned to the unreleased Solicitation 
Amendment at the time of creation, for tracking purposes.

A-Modification

A modification issued by the contract administration/management office.

Announcement 

Pre-award and Post-award notices designed to give vendors information on specific 
procurements.

Archiving

The process of removing transactions from the production database upon the expiration
of the staging period. This process is separate from the award closeout process. 

Attachment

Official documents associated to a contract file. Attachments are a part of the official 
contract document. In a UCF award document, attachments are listed in Section J. 

Audit

Report resulting from a Price/Cost Evaluation of a Contractor's Proposal.

Authenticated CAR Header

Status describing a CAR that has been validated on the FPDS-NG web site, with no 
errors returned except for the Date Signed. 

Award

An award is a procurement instrument that serves as a legally binding document 
between the government and a vendor. This includes: Contracts, Purchase Orders, 
Agreements, Orders, and Modifications.

Award Administrator

A user responsible for creating modifications to and orders off of an Award.
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Award Date

Contracting Officer's signature date on the award document.

Award Fee

An award amount that the contractor may earn in whole or in part during performance 
and that is sufficient to provide motivation for excellence in such areas as quality, 
timeliness, technical ingenuity, and cost-effective management and can be applied to 
any contract type in accordance with DFARS 216.470.

Award Type 

Award Type is equivalent to Form Type (e.g. SF-1449, DD-1155) 

Base Fee

The set fee that a contractor will earn for performance of a Cost Plus Award Fee (CPAF)
contract in addition to any Award Fee. The base fee is fixed at contract award.

Base Line Item

A line item that is not an option line item.

Basic Agreement (BA)

A written instrument of understanding, negotiated between an agency or contracting 
activity and a contractor that contains contract clauses applying to future contracts 
between the parties during its term and contemplates separate future contracts that will 
incorporate by reference or attachment the required and applicable clauses agreed upon
in the basic agreement. A basic agreement is not a contract. 

Basic Ordering Agreement (BOA)

A written instrument of understanding, negotiated between an agency or contracting 
activity and a contractor to be used in future work. Terms and Conditions include such 
areas as a description of the supplies and/or services to be provided, and methods for 
issuing, pricing, and delivering future orders. 

Bilateral Action

An Award/Award Modification that requires the contractor's signature prior to the 
signature of the contracting officer. 

Blanket Purchase Agreement (BPA)

A simplified method of filling anticipated repetitive needs for supplies or services by 
establishing charge accounts with qualified sources of supply. 
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Commercial and Government Entity (CAGE)

A CAGE Code is a five (5) position code that identifies companies doing, or wishing to 
do, business with the Federal Government. Foreign vendors use a NCAGE Code in lieu 
of a standard CAGE code. The code is used to support a variety of mechanized systems 
throughout the government. The code provides for a standardized method of 
identifying a given facility at a specific location. 

Cancellation

The cancellation of a requirement in the pre-award phase of the procurement process, 
or post award phase for Purchase Orders where performance has not started and no 
cost to the government has yet occurred. Cancellations are either full or partial. Full no 
cost cancellation applies to an entire Purchase Order. Partial no cost cancellation refers 
to the Purchase Order but apply to line item(s). (For Example: Line Item 0001 with a 
quantity of 100 may be cancelled fully at no cost, but Line Item 0002 not cancelled).

Contract Data Requirements List (CDRL)

The standard format for identifying potential data requirements in a solicitation and 
deliverable data requirements in a contract.

The DD Form 1423, Contract Data Requirements List, is always an exhibit, rather than 
an attachment. Each CDRL item is an ELIN. 

Contracting Officer (KO)

A Contracting Officer is an official with the authority to obligate money for the federal 
government. The Contracting Officer uses the bulk of the processes and features within 
the federal system and his/her duties include issuing solicitations, awards, 
modifications and orders. This individual is also authorized by virtue of position or by 
appointment to perform the functions assigned by the Federal Acquisition Regulations.

Ceiling Percent

The percentage of Ceiling Price to Target Cost in a Fixed Price Incentive (FPI) contract. 
Ceiling % = Ceiling Price / Target Cost.

Ceiling on Firm Target Profit

The maximum amount to be negotiated for Target Profit when firm targets are set in a 
FPIS contract.

Ceiling Price

The maximum amount that may be paid to the contractor in a Fixed Price Incentive 
(FPI) type contract.

Central Contracting Registry (CCR)

The Central Contracting Registry (CCR) is a central database containing basic business 
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information where all vendors wishing to do business with the federal government 
under a FAR-based contract must be registered before being awarded a contract.

Classification 

A marking that indicates the sensitivity level of a classified page, document, or item, 
such as Confidential, Secret, Top Secret, or Unclassified. These Markings display 1/3 
larger than the rest of the text in printed output. 

Classification Block

A set of markings that include Classified By, Reason, and Declassify On information.

Classification Reason

A concise justification for classification by the original classifier which, at a minimum 
cites the applicable classification categories in section 1.5 of E.O. 12958 (From DoD 
Guide to Marking Classified Documents, April 1997) as the basis for classification. 

Contract Line Item Number (CLIN)

Contract Line Item Number

Closed-out 

The term used to describe an award that is physically complete and has gone through 
the procurement closeout process. A closed transaction may or may not be fully 
liquidated. 

Codeword

An unassociated "word" assigned by program management to represent a DoD project. 

Confirming Order 

An Order confirming a previously issued verbal order. 

Conform

Confirming a solicitation or amendment.

Conformed Copy

A system-generated representation of the Purchase Request, Solicitation or Award 
document reflective of the latest processed Amendment or Modification to be used for 
reference purposes.

Contract Type

A selection of pricing structures available to the Government when procuring items. 
Contract types vary according to (1) The degree and timing of the responsibility 
assumed by the contractor for the costs of performance; and (2) The amount and nature 
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of the profit incentive offered to the contractor for achieving or exceeding specified 
standards or goals. The contract types are grouped into two broad categories: 
fixed-price contracts and cost-reimbursement contracts. The specific contract types 
range from firm-fixed-price, in which the contractor has full responsibility for the 
performance costs and resulting profit (or loss), to cost-plus-fixed-fee, in which the 
contractor has minimal responsibility for the performance costs and the negotiated fee 
(profit) is fixed. In between are the various incentive contracts, in which the contractor's 
responsibility for the performance costs and the profit or fee incentives offered are 
tailored to the uncertainties involved in contract performance.

Contracting Officer Technical Representative (COTR)

Individual designated and authorized in writing by the Contracting Officer to perform 
specific technical or administrative functions.

Contracting Officer Technical Representative Address (COTR Address)

The address for the respective COTR, Contracting Officer Technical Representative. A 
stakeholder who has responsibility around the contract. Within the system, their duties 
could include accepting deliverables under the contract, receiving notifications related 
to the contract. 

Contracting/ Issuing Office

An office that can issue solicitations, awards, orders, amendments, and modifications. 

Cost Code

A DoD accounting line field used to differentiate similar lines of accounting. If cost code
is included in the Accounting Line Fields it is considered part of the Line of Accounting.

Cost Reimbursement

Under a cost-reimbursement contract, the contractor agrees to provide its best effort to 
complete the required contract effort. Cost-reimbursement contracts provide for 
payment of allowable incurred costs, to the extent prescribed in the contract. These 
contracts include an estimate of total cost for the purpose of obligating funds and 
establishing a ceiling that the contractor cannot exceed (except at its own risk) without 
the approval of the contracting officer. 

Cut-Off Date

End date and time for receipt of final revisions to offers following negotiations. 

Data Item/Requirement 

A requirement, identified in a solicitation and imposed in a contract or order that 
addresses any aspect of data; i.e., that portion of a contractual tasking requirement 
associated with the development, generation, preparation, modification, maintenance, 
storage, retrieval, and/or delivery of data. Data items are exhibit line items that can 
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reside in CDRLs.

Debarment 

Action taken by a debarring official to exclude a contractor from Government 
contracting and Government-approved subcontracting for a reasonable, specified 
period; a contractor that is excluded is "debarred." 

Delivery Instance

An individual delivery slated for a particular line item.

Delivery Office

An office location that can accept/receive deliveries.

Delivery Order

An Order for supplies placed against an established contract or agreement or with 
Government sources. 

Delivery Schedule

Combination of delivery instances (presumably different) related to a single line item.

Description of Modification 

Modification specific items that include Change/Cancel Reason Code Text, Summary of 
Change statements, and modification only text that do not update the conformed copy.

Discontinuation

The process used to stop actions from being taken against a processed agreement. 

Distribution Statement

A statement used in marking technical data to denote the extent of its availability for 
secondary distribution, release, and disclosure without need for additional approvals or
authorizations from the controlling DoD office. (Refer to DoD Directive 5230.24, 
"Distribution Statements on Technical Documents (reference (c)). 

DoD Program Code

The DoD Program Code designates that the specific item being acquired is in support of
a specifically designated DoD Program. For example, if a contracting action is funded 
by the Ballistic Missile Defense Organization (BMDO), enter code CAA. Specific codes 
have been established to identify environmental cleanup programs and are used for all 
transactions involving environmental acquisitions. A list of the Environmental Cleanup 
Program Codes is found in the DoD Procurement Coding Manual, Section II Program 
and System or Equipment Codes (Description and Use of Program Codes). 
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Department Of Defense Activity Address Code (DODAAC)

A six (6) character code that uniquely identifies a unit, activity or organization that has 
the authority to requisition and/or receive material. 

Defense Priorities and Allocations System Rating (DPAS Rating)

There are two levels of ratings, identified by "DO" and "DX". All DO ratings are of equal
value and take precedence over unrated orders. All DX rated orders are of equal value 
and take priority over DO and unrated orders. A priority rating consists of the rating 
symbol (DO or DX) followed by the program identification symbol (e.g. A1, X7). An 
example DPAS priority rating is DO-A1. The program code itself does not designate 
priority with DO or DX ranges. The specific list of Program Identification Symbols is 
contained in 15 CFR 700 Schedule 1 Approved Programs and Delegate Agencies, 
Defense Priorities Allocations System Regulations.

The Defense Priorities and Allocations System (DPAS) was established to ensure the 
timely availability of industrial resources to meet national defense requirements and 
provide a framework for rapidly expanding industrial resources in a national 
emergency. The DPAS rating is assigned to all military systems used in support of 
national defense, from the largest finished platform to the smallest component. It can be
applied to all stages of acquisition research and development, initial design, production 
testing, delivery, and logistics support.

Defense Switching Network (DSN)

Defense Switching Network phone number.

DUNS and DUNS + 4

The Dun & Bradstreet unique nine (9)-digit DUNS Number associated with an 
organization. DUNS+4 numbers are used to identify different CCR records for the same 
vendor at the same physical location. For example, a vendor could have two records for 
themselves at the same physical location to identify two separate bank accounts. 

Effective Date

Date a Procurement Instrument becomes active.

Electronic Signature

Electronic Signature is a computer data compilation of any symbol or series of symbols, 
executed, adopted, or authorized by an individual to be the legally binding equivalent 
of the individual's handwritten signature. Thus signed electronic records contain the 
following information: 

• Name of the Signer

• Title of the Signer
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• Date and time the signature was executed

Estimated Cost

The anticipated amount of costs to be incurred in the performance of a Cost Type 
contract (CPFF, CPAF, Cost).

Estimated Max Cost

In an Indefinite Delivery/ Indefinite Quantity Cost Sharing Contract, the maximum cost 
for the supplies or services that the Government may order and the contractor is 
required to furnish.

Estimated Price

The extended price for the estimated total quantity in an IDC Requirements type 
contract line.

Exchange Rate

The fluctuating, trade-weighted price of one country's currency in terms of another, as 
determined by the Federal Reserve Bank of New York on behalf of the U.S. Treasury.

Expired Agreements

The suspended state of an agreement that has exceeded its end date.

Express CAR Category

The Express CAR (Contract Action Report ) Category allows a user to process an 
Award/Award Modification without first creating a CAR Header, Exemption to 
Reporting, or Reason for Not Reporting.

Express CAR Header

A CAR Header that allows for multiple Awards/Modifications with the same Express 
CAR Category and Issuing Office Code to be added to a single CAR Header.

Extended Price

The value of the Quantity times the Unit Price.

Facilities Capital Cost of Money (FCCOM)

An imputed cost related to the cost of contractor capital committed to facilities.

Federal Supply Class (FSC)

The Federal Supply Class (FSC) is a four-character code. Each FSC covers items that are 
usually requisitioned or issued together; or items that constitute a related grouping for 
supply management purposes.
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Firm Target Profit

Target Profit when firm targets are set in a FPIS contract.

Fiscal Year

DoD fiscal year begins 1 October and ends 30 September each year. 

Fixed Fee

The set fee that a contractor will earn for performance of a Cost Plus Fixed Fee (CPFF) 
contract.

Fixed Fee Percent

The percentage of estimated cost that the fixed fee represents in a Cost Plus Fixed Fee 
(CPFF) contract. Fixed Fee % = Fixed Fee divided by Estimated cost

Fixed Price

Under a fixed-price contract, the contractor agrees to deliver the product or service 
required at a price not in excess of the agreed-to maximum. Fixed-price contracts 
should be used when the contract risk is relatively low, or defined within acceptable 
limits, and the contractor and the Government can reasonably agree on a maximum 
price. Contract types in this category include:

• Firm fixed-price (FFP)

• Fixed-price economic price adjustment (FPEPA)

• Fixed-price award-fee (FPAF)

• Fixed-price incentive firm (FPIF)

• Fixed-price incentive with successive targets (FPIS)

• Fixed-price contract with prospective price redetermination (FPRP) 

• Fixed-ceiling-price contract with retroactive price redetermination (FPRR)

• Firm fixed-price level of effort term contract (FFPLOE)

Floor on Firm Target Profit

The minimum amount to be negotiated for Target Profit when firm targets are set in a 
FPIS contract.

Foreign Military Sales (FMS)

Case Numbers are assigned to track funds and actions. That portion of United States 
security assistance authorized by the Foreign Assistance Act of 1961, as amended, and 
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the Arms Export Control Act of 1976, as amended. This assistance differs from the 
Military Assistance Program and the International Military Education and Training 
Program in that the recipient provides reimbursement for defense articles and services 
transferred. 

Federal Procurement Data System, Next Generation (FPDS-NG)

Federal Procurement Data System, Next Generation (FPDS-NG) is an external 
application maintained by Global Computer Enterprises which collects contract data 
from all Services and Agencies in the Government for reporting purposes. Congress 
and federal departments and Agencies use FPDS-NG to track small business goals, 
report number and amount of contracts to date, show geographical placement of 
contracts, and summarize contract data for a specific contractor.

All Awards and modifications to such must be reported to FPDS-NG unless valid 
Exemptions to Reporting, Reasons for Not Reporting, or Express CAR Categories are 
defined. 

Government Estimate

An estimate of the cost for goods and/or estimate of services to be procured by contract. 
Such estimates are prepared by government personnel, i.e., independent of contractors. 

Government Objective

Government's initial negotiation position, based on analysis of the offeror's proposal, 
taking into consideration all pertinent information including field pricing assistance, 
audit reports and technical analysis, fact-finding results, independent Government cost 
estimates and price histories. 

Government Share

The amount of costs that the government will pay in a cost sharing contract.

Government Share Percent

The percentage of the total costs incurred by the contractor that the government will 
pay in a cost sharing contract. 

Govt. Share Above Target

The Percentage of cost risk assumed by the Government above the target cost in the 
formula for adjusting the target profit or target fee in FPI or CPIF contracts respectively.

Govt. Share Below Target

The Percentage of cost risk assumed by the Government below the target cost in the 
formula for adjusting the target profit or target fee in FPI or CPIF contracts respectively.
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Handling Caveat

Additional Markings on a page, document, or item that indicate how and where to limit
the distribution.

Header

Term used to denote summary level information versus line item level information.

IDC Document Level Constraints

• Contract Award Minimum Quantity (Minimum Guarantee Award Quantity 
Percentage) - The minimum percent of the quantity guaranteed to be ordered.

• Contract Minimum Quantity - the minimum Quantity that must be ordered for all 
line items over the life of the contract across all orders.

• Contract Maximum Quantity - the maximum Quantity that can be ordered for all 
line items over the life of the contract across all orders.

• Contract Award Minimum Quantity (Minimum Guarantee Award Amount 
Percentage) - The minimum percent of the amount guaranteed to be ordered.

• Contract Minimum Amount - the minimum Amount that must be ordered for all 
line items over the life of the contract across all orders.

• Contract Maximum Amount - the maximum Amount that can be ordered for all 
line items over the life of the contract across all orders.

• Contract Order Start Date - The projected start date for the ordering period.

• Contract Order End Date - The projected start date for the ordering period.

• Contract Order Minimum Quantity - the minimum Quantity that must be ordered 
for all line items on an individual order.

• Contract Order Maximum Quantity - the maximum Quantity that can be ordered 
for all line items on an individual order.

• Contract Order Minimum Amount - the minimum Amount that must be ordered 
for all line items on an individual order.

• Contract Order Maximum Amount - the maximum Amount that can be ordered for 
all line items on an individual order. 

IDC Types

There are three types of IDC contracts:
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• Definite Quantity – A definite-quantity contract provides for delivery of a definite 
quantity of specific supplies or services for a fixed period, with deliveries or 
performance to be scheduled at designated locations upon order.

• Indefinite Quantity – An indefinite-quantity contract provides for an indefinite 
quantity, within stated limits, of supplies or services during a fixed period. The 
Government places orders for individual requirements. Quantity limits may be 
stated as number of units or as dollar values. 

• Requirements – A requirements contract provides for filling all actual purchase 
requirements of designated Government activities for supplies or services during a 
specified contract period, with deliveries or performance to be scheduled by placing
orders with the contractor. 

Indefinite Delivery Contract (IDC)

A contract for supplies and/or services that does not procure or specify a firm quantity 
of supplies (other than a minimum or maximum quantity) and that provides for the 
issuance of orders for the delivery of supplies during the period of the contract.

Indefinite Delivery Vehicle (IDV)

Encompasses all indefinite delivery contracts, Blanket Purchase Agreement, Blanket 
Ordering Agreement, or any other agreements against which individual orders or calls 
may be placed in accordance with agency procedures.

Informational [line/subline]

A line or subline that does not contain specific quantity and pricing information.

Invoice Office

An office that can receive invoices.

Justification and Approval (J&A)

Documentation used to justify soliciting and awarding a contract without full and open 
competition.

Job Order Number (JON)

A number that links funding to a specific job or task.

Labor-Hour and Time-and-Materials

There are two other types of compensation arrangements that do not completely fit the 
mold of either fixed-price or cost-reimbursement contracts. Labor-hour and 
time-and-materials contracts both include fixed labor rates but only estimates of the 
hours required to complete the contract. They are generally considered to most 
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resemble cost-reimbursement contracts because they do not require the contractor to 
complete the required contract effort within an agreed-to maximum price; and the 
contractor is paid for actual hours worked.

• Labor Hour (LH)

• Time and Materials (TM)

Lease Agreement 

Same functionality as Basic Agreement, except the PIIN has a "L" in the 9th position 
(Type of Instrument) 

Line Item

This term is used generically to reference CLINs, Sublines, Exhibit Lines, Sub-Exhibit 
Lines.

Line Item Consolidation

The ability to combine multiple itemized lines into a single itemized line.

Line Item Estimated Amount

The government estimate of the cost of each individual line item.

Line Item Evaluated Amount 

Adjusted offer line item total when Price Adjustment Factors or Evaluation Preferences 
are entered. 

Line Item Offer Amount

The offered cost of each individual line item.

Line of Accounting (LOA)

The appropriation data, including all data elements and any document reference 
number which may be included.

List of Parties Excluded from Federal Procurement and Nonprocurement 
Programs 

A list compiled, maintained, and distributed by the General Services Administration 
containing the names and other information about parties debarred, suspended, or 
voluntarily excluded under the Nonprocurement Common Rule or the Federal 
Acquisition Regulation, parties who have been proposed for debarment under the 
Federal Acquisition Regulation, and parties determined to be ineligible. 

Marking Information

This field will default with one of the following: Codeword, Trigraph, or Nickname 
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from the Security Organization Table. The user will select which of the three will 
default on the form and it will be editable on the form. 

Maximum Ceiling Award Amount

The Maximum Amount that can be ordered over the life of the IDV.

Maximum Fee

The maximum fee is the greatest amount of fee that the contractor will earn no matter 
what fee is calculated using the target cost, target fee, and share ratio in a CPIF contract.

Maximum Price

In an Indefinite Delivery/ Indefinite Quantity Contract, the extended price for the 
maximum quantity of supplies or services that the Government may order and the 
contractor is required to furnish. Quantity limits may be stated as number of units or as 
dollar values.

Maximum Quantity

In an Indefinite Delivery/ Indefinite Quantity Contract, the stated maximum quantity of
supplies or services that the Government may order and the contractor is required to 
furnish. Quantity limits may be stated as number of units or as dollar values.

Major Defense Acquisition Programs/ Major Automated Information System 
Acquisition Programs (MDAPS/MAIS)

In order to be an MDAP, an acquisition program must either be designated by the 
USD(AT and L) as an MDAP or estimated by the USD(AT and L) to require an eventual 
total expenditure for research, development, test, and evaluation of more than $365 
million in FY 2000 constant dollars or more than $2.190B in procurement in FY2000 
constant dollars.

Media/Status Code

Indicates the recipient of status and the means of transmission. 

Military Standard Requisitioning and Issuing Procedures (MILSTRIP)

80 character string concatenating various piece of information and used in several 
legacy operations across the DoD. MILSTRIP is an acronym for Military Standard 
Requisitioning and Issue Procedures. 

Minimum Fee

The minimum fee is the lowest amount of fee that the contractor will earn no matter 
what fee is calculated using the target cost, target fee, and share ratio in a CPIF contract.

Minimum Hours

In a Labor Hour type Indefinite Delivery Contract, the stated minimum quantity of 
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hours that the Government is required to order and the contractor is required to 
furnish. Same as Minimum quantity in other Indefinite Delivery Contracts.

Minimum Quantity

In an Indefinite Delivery/Indefinite Quantity Contract, the stated minimum quantity of 
supplies or services that the Government is required to order and the contractor is 
required to furnish. Quantity limits may be stated as number of units or as dollar 
values.

Military Interdepartmental Purchase Request (MIPR)

A request from one agency to another agency for goods and services that also transfers 
funding. A type of requisition. 

Modification

A Procurement Instrument used in the post-award process for the purpose of making a 
change to the award. The conformed copy is not updated with the information from the
Modification until the Modification is processed. 

Modification Control Number

A unique supplemental numbering sequence that is assigned to the unprocessed 
Award, Order, or Agreement Modification at the time of creation, for tracking 
purposes.

Modification Issuing Address

This is the office responsible for completing the modification. Each modification can 
have a different Issuing office than the Award's Issuing office.

Multiple CAR

Multiple Contract Action Report - Used when a user needs to split the FPDS reporting 
of Award/Award Modification line items into multiple reports. For example, the user 
might have Firm Fixed Price and Cost type Line Items on an Award, so the user can use 
the Multiple CAR reporting method to report each line item on a different CAR Header.

Multiple Modification

A term used when multiple conformed copies of any Awards, Delivery Orders, 
Agreements, and Agreement Orders are changed via multiple modification 
functionality.

Multiple modification functionality creates individual modifications for each 
user-selected Award, Delivery Order, Agreement, and Agreement Orders 
simultaneously. 
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Negotiation

Phase where the Government and the Contractor negotiate award changes (For 
example: termination settlement). 

Nickname

An unclassified representation of a program and/or compartment to which a page, 
document, or item is associated. This is stored in the Security Organization table.

No Cost Settlement

This is a type of Termination. The Government uses the term "no cost" settlement to 
describe the terminations where there will not be a settlement cost. (For example: 
Termination for convenience that results in no settlement cost). 

North American Industry Classification System (NAICS) Code

The North American Industry Classification System (NAICS) has replaced the U.S. 
Standard Industrial Classification (SIC) system, and was developed jointly by the U.S., 
Canada, and Mexico to provide new comparability in statistics about business activity 
across North America. 

National Stock Number (NSN)

A National Stock Number (NSN) is a thirteen (13) digit number assigned to an item of 
supply. It consists of the four digit Federal Supply Class (FSC) and the nine digit 
National Item Identification Number (NIIN). The NSN is used as the common 
denominator to tie together logistics information for an item of supply. A NIIN is a 
unique nine character code assigned to each item of supply purchased, stocked or 
distributed within the Federal Government; when combined with the four character 
FSC it composes the NSN. The NIIN is used as the common denominator for an item of 
supply 

Offer

Response to a solicitation that if accepted, would bind the offeror to perform the 
resultant contract; this also includes subsequent revisions to offers. 

Offer Evaluation

A procurement vehicle created for the purpose of summarizing and evaluating all offers
received for a given Solicitation.

Office

A government organization that has some responsibility in the acquisitions process. An 
office can have more than one address type and more than one contact. 
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Option

An option "means a unilateral right in a contract by which, for a specified time, the 
Government may elect to purchase additional supplies or services called for by the 
contract, or may elect to extend the term of the contract" (FAR 2.101).

Option Line

A contract line item that is representative of an option (see Option definition). An 
option line is identified by an option indicator and is not a base line item.

Order

A procurement instrument for supplies/services placed against an established contract 
or agreement or with Government sources. 

Order End Date

Date on which orders can no longer be placed against an Agreement. 

Order Start Date

Beginning date on which Orders (Contracts in case of Basic Agreements) can be placed 
against an Agreement. 

Ordering Instrument

A procurement instrument from which an Order, Call or Contract is created.

Organization

See definition for "Office."

Other Direct Costs (ODC)

In a Time and Materials (T & M) type contract, the estimated amount for materials and 
incidental services for which there is not a labor category specified in the contract, such 
as travel, computer usage charges, etc.

Procurement Action Lead Time (PALT)

The time, measured in days, between the start date and the actual completion date of a 
workload assignment, minus any suspended PALT time. 

Payment Bonds

A written instrument executed by a bidder or contractor (the principal) and the second 
party (the "surety" or "sureties") to assure fulfillment of the principal's obligation to a 
third party (the "obligee" or "Government") identified in the bond. If the principal's 
obligations are not met, the bond assures payment to the extent stipulated, or any loss 
sustained by the obligee. 



Glossary-19

Payment Office

An office that makes payments under the contract/order.

Performance Bonds

A written instrument that secures performance and fulfillment of the contractor's 
obligations under the contract.

Physical Completion Date

The date in which an award is complete based on when the contractor has completed 
the required deliveries and the Government has inspected and accepted the supplies, all
services have been performed and have been accepted by the Government, all option 
provisions have expired, or the Government has given notice of complete contract 
termination. For facilities contracts, rentals, use and storage agreements this date is 
based on when the Government has given notice of complete contract termination or 
the period has expired (FAR 4.480-4 details the contract physical completion 
regulations). The physical completion date, along with the type of contract, is used to 
calculate the projected closeout timeframe (refer to FAR 4.804-1 for the time standards). 

Place of Performance

Designated location where services will actually be rendered.

P-Modification

A modification issued by the procuring contracting office.

Portion Markings

Portion Markings let the user of the information know at what level that paragraph 
within the classified page, document, or item should be protected. The Portion Marking 
will be comprised of the Classification and Trigraph. 

Pre/Post Negotiation Position (PNP)

Working document used to capture and analyze key price/cost data leading up to a 
negotiated contract change.

Precious Metal Code

A single alphanumeric code used to identify items that contain precious metal(s).

Priced [line/subline]

A line or subline that contains specific quantity and pricing information.

Procurement Instrument

Generic term to describe acquisition documents that can be created during the 
acquisition process. Documents include Solicitations, Amendments, Awards, 
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Agreements, Orders and Modifications.

Procurement Instrument Identification Number (PIIN)

Number assigned to procurement instruments. The number consists of 13 
alpha-numeric characters grouped to convey certain information.

Positions 1 through 6. The first six positions identify the department/agency and office 
issuing the instrument. Use the DoD Activity Address Code (DoDAAC) assigned to the 
issuing office. DoDAACs can be found at https://day2k1.daas.dla.mil/daasinq/

Positions 7 through 8. The seventh and eighth positions are the last two digits of the 
fiscal year in which the PII number was assigned.

Position 9. Indicate the type of instrument by entering one of the following upper case 
letters in position nine.

• Blanket purchase agreements - A

• Invitations for bids - B

• Contracts of all types except indefinite delivery contracts, facilities contracts, sales 
contracts, and contracts placed with or through other Government departments or 
agencies or against contracts placed by such departments or agencies outside the 
DoD - C

• Indefinite delivery contracts -D

• Facilities contracts -E

• Contracting actions placed with or through other Government departments or 
agencies or against contracts placed by such departments or agencies outside the 
DoD (including actions with the National Industries for the Blind (NIB), the 
National Industries for the Severely Handicapped (NISH), and the Federal Prison 
Industries (UNICOR)) - F

• Basic ordering agreements - G

• Agreements, including basic agreements and loan agreements, but excluding 
blanket purchase agreements, basic ordering agreements, and leases - H

• Do not use - I

• Reserved - J

• Short form research contract - K

• Lease agreement L

• Purchase orders--manual (assign W when numbering capacity of M is exhausted 
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during the fiscal year) - M

• Notice of intent to purchase - N

• Do not use - O

• Purchase order--automated (assign V when numbering capacity of P is exhausted 
during a fiscal year) - P

• Request for quotation--manual - Q

• Request for proposal - R

• Sales contract - S

• Request for quotation--automated (assign U when numbering capacity of T is 
exhausted during a fiscal year) - T

• See T - U

• See P - V

• See M - W

• Reserved for departmental use - X

• Imprest fund - Y

• Reserved for departmental use - Z

Position 10 through 13. Enter the serial number of the instrument in these positions. A 
separate series of serial numbers may be used for any type of instrument listed in 
paragraph (a) (3) of this section. Activities shall assign such series of PII numbers 
sequentially. An activity may reserve blocks of numbers or alpha-numeric numbers for 
use by its various components.

Procurement Profile

A set of unique characteristics that define certain personal details, warrant information, 
and certifications for a particular user. 

Project Code

Identifies requisitions and all perpetuated documents as to special programs, exercises, 
projects, operations, or other purposes. This field is not the Project Code relating to the 
MILSTRIP Component.
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Property Office

An office responsible for government property.

Proposal

An offer in a negotiated procurement.

Purchase Request (PR)

Generically, the documented means by which an agency requests that goods or services 
be procured for their use. Also known as requisition document.

Quantity Price Breaks (QPB) 

The ability to enter multiple quantity amounts or multiple quantity ranges within a line 
item for the purpose of establishing price breaks. 

Reason for Not Reporting

The Reason for Not Reporting allows a user to process an Award/Award Modification 
without first creating a CAR or Exemption to Reporting. The five authorized reasons 
are: Automatically Processed; FPDS-NG not Updated to Reflect DoD Requirements; 
Previously Reported; Technical/Connectivity Failure; or Urgent and Compelling Action.

Requesting Office

An office that initiates purchase requests.

Rescind

An official revocation of either a termination or discontinuation action on a processed 
document. 

Retention End Date

This is the next calendar date after the last day of the Retention Period and represents 
the day an award file becomes eligible to be destroyed in its entirety.

Retention Period

The timeframe a Government contract file must remain in existence.

Sealed Bid

Offer submitted to the Government in response to an Invitation for Bids which remains 
inaccessible until the indicated opening time. 

Security Markings

All of the marking information; Classification, Codeword, Nickname, Trigraph, 
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Classification Block, Handling Caveat, and Portion Marking. 

Security Screen Classifications

A means for visibly labeling data with site-defined Screen Markings. 

Settlement

Phase where the Government and the Contractor come to an agreement. A modification
is created to incorporate the settlement terms.

Ship To Address

An office location that can accept/receive deliveries. Synonymous with 'Delivery' office.

Shipment Mode

A way to designate how an item should be shipped. 

Signal Code

One-digit code, which identifies the "ship to" and, if applicable, "bill to" activities, i.e. 
the requisitioner or a supplementary activity. 

Signed Date

The signed date is the date that the contracting officer 'signs' the award. For the case of 
online use, the signed date is always equal to the Date that the Award is finalized in the 
user's time zone. This is the date when the Award has been finally approved in the 
system. At this point in time, the conformed record is created, financial transactions 
(e.g. obligation) are initiated, and related workload assignments are closed. For an 
inbound, integrated transaction (e.g., data migration, system integration from parallel 
contract-writing applications) the signed date must be able to be passed in as it existed 
on the award in the source system.

Simplified Acquisition Procedures (SAP)

DoD contracting policies and procedures for the acquisition of supplies and services, 
including construction, research and development, and commercial items, the aggregate
amount of which does not exceed the simplified acquisition threshold. Policies outlined 
in FAR Part 13.

Simplified Acquisition Threshold (SAT)

Commonly this is $100,000 but can be $5,500,000 for commercial items.

Single Contract Action Report (Single CAR)

Used when a user wants to report all line items from an Award/Award Modification 
together on a single CAR Header.
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Subline Number (SLIN)

A priced or informational line item that is a subordinate of a contract line. SLINs 
numbering will contain the parent CLIN number with an additional 2-characters. If the 
SLIN is an info line, the 2-characters will be numeric beginning with 01. If the SLIN is 
priced, the 2-characters will begin with AA.

Small Business Administration Office

An office that provides contracting support for small businesses.

Small Business Coordination Record 

The DoD Small Business Coordination Record (DD Form 2579) is used to screen 
proposed acquisitions to ensure: Consideration has been afforded small and small 
disadvantaged business concerns and that they receive an equitable opportunity to 
participate in the proposed acquisition.

Special Material Identification Code (SMIC)

Supplements the National Stock Number to provide visibility to designated items to 
ensure their technical integrity.

Solicitation

A procurement vehicle created to send to prospective contractors by a government 
agency, requesting the submission of Offers or of information. The generic term 
includes Invitation for Bids (IFBs), Request for Proposals (RFPs), and Request for 
Quotations (RFQs). 

Supplemental Procurement Instrument Identification Number (SPIIN)

Use supplementary numbers with the basic PII number, to identify:

• Amendments to solicitations

• Modifications to contracts and agreements, including provisioned item orders; and

• Calls or orders under contracts, basic ordering agreements, or blanket purchase 
agreements, issued by the contracting office or by a DoD activity other than the 
contracting office, including DoD orders against Federal supply schedules.

Staging Period

The timeframe a contract file remains in the procuring contracting office before being 
eligible to move to a records holding or staging area. 

Staging Period End Date

This is also referred to in this document as the 'Move from Production Date'. This is the 
next calendar date after the last day of the Staging Period and represents the day in 
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which the contract file is eligible to be archived. 

Sub Exhibit Line (SubELIN)

A child line of a parent exhibit line. Sub Exhibit Lines may be priced, if the parent is not,
or informational (if the parent line is priced).

Substantially the Same As

A designation of a term and condition that identifies the text of the term and condition 
can be edited on a procurement instrument. 

Summary of Changes Text

Free form text that provides information about document changes.

Supporting Document

An associated document not included in the formal award or solicitation. In an Uniform
Contract Format (UCF) award document, supporting documents are not listed in 
Section J. 

Transportation Accounting Code (TAC)

Used in the shipping and transportation process to link movement authority, funding 
approval, and accounting data for shipments of cargo and personal property in the 
Defense Transportation System (DTS). Typically entered with funding information at 
the line item or contract level. 

Target Cost

The negotiated amount of costs such that if the contractor completes the contract at the 
target cost, there will be no positive or negative cost incentives applied.

Target Fee

Target Fee is the amount of fee that the contractor will earn if the contractor completes 
the contract at the target cost in a CPIF type contract.

Target Profit

Target Profit is the amount of profit that the contractor will earn if the contractor 
completes the contract at the target cost in a FPI type contract.

Total Target Price

The sum of the Target Cost and Target Profit in a FPI type contract.

Technical Analysis Report (TAR)

Report resulting from a Technical Evaluation of a Contractor's Proposal.
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Technical Office

An office that assumes technical responsibility for requirements.

Termination

The discontinuation of one of more contract line items during the post-award phase of 
the procurement process. Termination may be for default, for convenience, or for cause.

• Default: A complete or partial termination of an award because of the contractor's 
actual or anticipated failure to perform its contractual obligations. The contractor is 
liable for cost associated with the termination.

• Convenience: To terminate or cancel performance of work under an award, in 
whole or part, if the Contracting Officer determines that termination is in the 
Government's interest. Both parties must negotiate an agreement.

• Cause:To terminate or cancel performance of work under an award of commercial 
items, if the Contracting Officer determines that termination is in the Governments' 
interest.

Terms and Conditions

Collective term used to describe Text, Clause, Provisions, and/or Articles. Terms and 
Conditions are used interchangeably with T's and C's, text and clauses. 

Total Amount of Contract

The sum of the line item amounts that have not been designated as options.

Total Amount Without Option

The sum of all contract lines excluding those lines that are indicated as options.

Total Estimated Amount

The government estimate amount of all line items.

Total Evaluation Amount

Adjusted total offer amount when Evaluation Preferences or Price Adjustment Factors 
are entered.

Total Obligated Amount

The sum of all funding amounts.

Total Offer Amount

The total cost of all line items offered.
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Transportation Rates

Additional amount for transportation or freight added to FOB.

Trigraph

A three character combination identifying the program and/or compartment a page, 
document, or item is associated. This marking is necessary to classify the document to 
the highest level of classification within the program/compartment. 

Unit Price

The price for a quantity of one of the unit of issue.

Vendor

An organization conducting business with the government. Also known as Supplier.

Verbal Order

An Order placed verbally by the PCO to a Vendor.

Warrant

A government form (SF1402) which specifies the limits of a Contracting Officer's 
authority when binding the Government to a contracting vehicle. Refer to FAR 1.602.1

A Warrant is required in order to process an award, order, agreement, and modification
to such.

Weapon System Code

Also known as Weapons System Designator Code (WSDC). These codes consist of three
alphabetical positions. The first position identifies one of the following major categories 
of equipment. The second position identifies a subdivision of the major category. The 
third position identifies the specific item. A description and use of these codes is found 
in the DoD Procurement Coding Manual, Section II Program and System or Equipment 
Codes.

(http://web1.whs.osd.mil/peidhome/guide/mn02/mn02.htm). Note: WSC will be 
changed pending incorporation of MDAPs and MAISs. 

Withdrawal of Offers

A formal request by the vendor to have their offer/bid/revisions withdrawn from 
consideration.

Workload Assignment

A workload assignment consists of tasks (also called milestones) that the buyer needs to
accomplish in the given timeframe. A workload assignment is created for pre-award 
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activities, post-award activities and award administration activities.
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